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About this Guide
In About this Guide...

This portion of the user guide contains the following sections:

• Purpose.....2

• Audience.....2

• Manual Contents.....2

• Conventions Used in This Guide.....3

• Related Manuals.....3

• Online Help.....4

• How to Contact Us.....4
SmartApplications User Guide 1



About this Guide
Purpose

2

Purpose
This user guide provides information on all procedures required to perform tests using
SmartApplications 2.50 application software. This includes details on software
installation, test setup, and test result interpretation.

Audience
This user guide is for users of SmartApplications 2.50 software. It is assumed that users of
this guide are familiar with Microsoft Windows and SmartBits equipment, and have an
intermediate knowledge level of data communications theory.

Manual Contents
This guide contains the following chapters:

Chapter Title Description

1 SmartApplications Overview Provides an overview of SmartApplications.

Basic Test Theory Explains general theory of operation and rules for testing.

3 Install and Connect Lists system requirements and explains how to connect your PC to
the SmartBits and DUT.

4 Basic Navigation and Tools Describes the SmartApplications main window and results
windows, including menus and task buttons.

5 Set Up Tests Explains procedures required to set up SmartApplications tests.

6 Run Tests Explains procedures to start, stop, and run tests, and view reports.

7 Test Examples Provides sample test scenarios and explains test results.
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About this Guide
Conventions Used in This Guide
Conventions Used in This Guide
This guide uses the following conventions:

• Italics are used for document names and special terms.

• Menu options, field names, and tab names are bolded.

• Paths are shown with “greater than” symbols: Test > Setup Options > Throughput.
In this example, you would click on the Test menu option, then on the Setup Options
selection, and then on the Throughput tab.

• Directory and file names are shown in Helvetica.

• The terms packet and frame are used interchangeably.

• The term card is used to refer generally to any SmartCard or module for SmartBits
systems.

Notes, cautions, and other important user information are shown as follows:

Note: Includes related information and tips.

! Caution: Includes related precautions.

Important: Includes related important.

Warning: Includes related warnings to prevent damage to equipment and or injury.

Related Manuals
Additional SmartBits documentation that is related to this User Guide include:

• SmartBits Getting Started

• SmartBits System Overview and Reference

• Using GPS with SmartBits
SmartApplications User Guide 3



About this Guide
Online Help

4

Online Help
SmartApplications provides online Help for all windows and tabs. You can access online
Help in two ways:

• Press the F1 key from the window about which you wish information.

• From the menu bar, select Help > Contents to view the entire contents of the Help
file or Help > Search for Help On to search by a specific topic or word.

Chart Facility Help

SmartApplications includes a chart facility that can be used to represent test results
graphically. The facility contains a separate Help file called First Impression. If you
access Help from a chart-related window in either of the ways listed above, you will view
chart-related Help only. Once you return to the Results window, you can view
SmartApplications Help.

How to Contact Us
Technical support is available Monday through Friday between 07:00 and 18:00 Pacific
Standard Time.

To obtain technical support for any product, please contact our Technical Support
Department using any of the following methods:

Phone: +1 800.886.8842 (available in the U.S. and Canada)

+1 818.676.2589

Fax: +1 818.880.9154

E-mail: smartbits.support@spirentcom.com

In addition, the latest versions of application Help files, application notes, and software
and firmware updates are available on our website at:

http://www.spirentcom.com

Company Address

Spirent Communications of Calabasas
26750 Agoura Road
Calabasas, CA 91302
USA

+1 818.676.2300
SmartApplications User Guide

http://mailto:support@netcomsystems.com
http://www.netcomsystems.com


1
 SmartApplications Overview
In this Chapter

This chapter contains the following sections:

• What is SmartApplications?.....6

• What are SmartCards and Modules?.....7

• Supported Cards and Modules.....7
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Chapter 1: SmartApplications Overview
What is SmartApplications?

6

What is SmartApplications?
SmartApplications is an easy-to-use suite of tests for LAN switches and routers
connecting to Ethernet, ATM, Wide Area Network (WAN), or Token Ring networks. It
enables you to test how well a device performs with either packet-based or stream-based
network traffic, as simulated by the SmartBits system. You can assess the performance of
a device under test (DUT) with up to 768 ports.

SmartApplications tests are based on:

• RFC 1242, Benchmarking Terminology for Network Interconnection Devices, edited
by Scott Bradner (sob@harvard.edu)

• An informational document, Benchmarking Methodology for Network Interconnect
Devices, edited by Scott Bradner

• RFC 2544, Benchmarking Methodology for Network Interconnect Devices, edited by
Scott Bradner and Jim McQuaid (mcquaidj@netscout.com)

RFC 1242 and RFC 2544 outline the following tests for network devices:

• Throughput

• Latency

• Frame Loss Rate

• Back-to-Back

These tests are implemented in SmartApplications.

RFC 1242 also contains a complete definition of the terms for which the tests are named.
RFC 2544 describes how to measure and test performance, including specific formats in
which to report test results and maximum frame rates to use with specific frame sizes.

RFC 1242 and RFC 2544 are available at www.ietf.org.

The informational document is available at the NDTL ftp site: ndtl.harvard.edu.
SmartApplications User Guide
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What are SmartCards and Modules?
What are SmartCards and Modules?
SmartCards and modules are custom-designed printed circuit boards (PCBs) that fit within
a SmartBits chassis to generate, capture, and analyze network packet data.

SmartBits systems use two types of cards and modules, depending on chassis type.

SmartCards are designed to fit into the SMB-2000 and SMB-200 chassis.

Modules are designed to fit into the SMB-6000B and SMB-600 chassis. They provide a
higher port density than do SmartCards.

For simplicity, the term card is sometimes used to refer to any SmartCard or module in a
SmartBits system.

Supported Cards and Modules
SmartApplications 2.50 may be used with the follow SmartCards and modules.

Table 1-1. Supported SmartCards and Modules

Chassis Network Topology SmartCard or Module

SMB-6000 10/100Mb Ethernet LAN-6100A 100Mb Ethernet TP

LAN-6101A 10/100Base-TX SmartMetrics

Gigabit Ethernet LAN-6200A(s) 1000Base-SX

LAN-6201A(s) 1000Base-SX SmartMetrics

LAN-6201B 1000Base-X GBIC SmartMetrics

SMB-600/6000B 10/100Mb Ethernet LAN-3100A 10/100Base-TX SmartMetrics

LAN-3101A 10/100Base-TX TeraMetrics

LAN-3102A 10/100Base-TX SmartMetrics

LAN-3111A 100Base-FX SmartMetrics

LAN-3302A 10/100Base-T TeraMetrics

10/100/1000Mb Ethernet
and
Gigabit Ethernet

LAN-3200A(s) 1000Base-SX

LAN-3201As 1000Base-SX SmartMetrics

LAN-3201B 1000Base-X GBIC SmartMetrics

LAN-3300A 10/100/1000Base-T SmartMetrics
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Chassis Network Topology SmartCard or Module

SMB-600/6000B
(continued)

10/100/1000Mb Ethernet
and
Gigabit Ethernet
(continued)

LAN-3301A 10/100/1000Base-T TeraMetrics

LAN-3310A 1000Base-X GBIC SmartMetrics

LAN-3311A 1000Base-X GBIC TeraMetrics

SMB-200/2000 ATM AT-9015 1.544Mb T1

AT-9020 2.048Mb E1

AT-9025 25Mb

AT-9034(B) 34Mb E3

AT-9045B 45Mb DS3

AT-9155(C)(Cs) 155Mb

AT-9622(s) 622Mb

Gigabit Ethernet GX-1405B(s) 1Gb Ethernet Fiber

GX-1420A 1Gb Copper Ethernet TP

GX-1420B 100Mb/1Gb Copper Ethernet TP

10Mb Ethernet ML-5710 100Mb SmartMetrics Ethernet and USB
(only Ethernet mode is supported)

ST-6410 10Mb Full Duplex Ethernet TP

100Mb Ethernet ML-7710 100Mb SmartMetrics VLAN Ethernet TP

ML-7711 100Mb SmartMetrics VLAN Ethernet Fiber

SX-7210 100Mb Ethernet VLAN MII

SX-7410B 100Mb Ethernet VLAN TP

SX-7411 100Mb Ethernet VLAN Fiber

Token Ring TR-8405 4/16 Token Ring

WAN WN-3405 8Mb V.35 Frame Relay

WN-3415 1.544Mb T1 Frame Relay

WN-3420A 2.048Mb E1 Frame Relay

Table 1-1. Supported SmartCards and Modules (continued)
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General Testing Methodology
Each SmartApplications test has two features in common:

• Each test measures device forwarding capabilities, and

• Each requires a pair of SmartBits SmartCards to test frame forwarding: one card is the
transmitter, the other is the receiver.

Before testing a device you must:

1 Identify the number of the ports you want to test.

2 Ensure that each port to be tested has a unique MAC address.

You can chose multiple packet sizes and test durations, as specified in the RFC.

SmartApplications logs test results into individual standard ASCII files that you can view
or print with standard utilities.

Test Terminology

Test The term test refers to the test type, such as Throughput or Latency, run for a specific
frame size.

Iteration An iteration occurs when SmartApplications varies the transmission rate, based on the last
failed rate, while maintaining the frame size. The specified test resolution and number of
repetitions determines the accuracy of results.

Trial A trial is a set of iterations for a specific frame size, with varying transmission rates.
Within a test, trials are used to determine the optimal rate of traffic for that frame size. It is
possible to have multiple trials for one frame size. Detailed results display multiple trial
results. You specify the number of trials in the Setup Test Configuration window.

Figure 2-1 illustrates these terms.

Figure 2-1. Trial and Iterations for a Sample Test Configuration

Sample Test Configuration
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Address Learning for SmartCards
SmartApplications assumes that the device under test (DUT) has no knowledge of any
forwarding or routing required. To initialize the DUT’s forwarding tables, the SmartBits
sends learning packets.

You can also instruct the SmartBits to send learning packets between every test trial, to
refresh a device forwarding table before addresses are eliminated by aging.

Table 2-1 shows the makeup of the learning packets that are sent.

Table 2-1. Learning Packet Contents

Packet Area Size (Bytes) How Used

Destination 6 MAC address.

Source 6 MAC address.

Protocol Variable Matching user selection of IP, UDP, IPX, or 32 bytes of
All zeros or All 0xFF.

Test Specific 12 Packet Loss and Back-to-Back
Six bytes of the SmartBits stamp in an ASCII string
(NETCOM), and six bytes of the destination address.

Throughput
A six-byte incrementing counter with six bytes of
destination MAC address.

Latency
A six-byte decrementing counter with six bytes of
destination MAC address.

Rest of Packet n Length varies, depending on the fill pattern for the
selected protocol type.

CRC 4 Error detection.
SmartApplications User Guide 11
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Throughput Test Methodology
The Throughput test tests the fastest rate at which a device can forward frames without
error. If a single frame is dropped, the test fails and is repeated at a lower throughput rate.

The throughput test satisfies the terminology criteria of RFC 1242 and the test
methodology specified in RFC 2544. From RFC 1242, throughput is:

“the maximum rate at which none of the offered frames are dropped by the device.”

From RFC 2544, the methodology to measure throughput is to:

“send a specific number of frames at a specific rate through the DUT and then count
the frames that are transmitted by the DUT.”

SmartApplications measures throughput by first sending a series of frames with a
particular source and destination MAC address to the device under test. The frames are
sent from one SmartBits port and are intended to be received by a second SmartBits port.

Interframe Gap InterFrame Gap is determined by the initial rate in the test setup. If the initial rate is set to
100%, frames are sent initially with the gap set to the minimum legal size for the topology
and speed of the transmitting SmartCard.

How frames are
sent and counted

The number of frames sent is determined by the length of time the test is to run. Frames
are validated by counting only frames generated by the sending port, not any packets sent
by the switch. Keep-alive and routing update frames are not counted as received frames.

Initial frame rate If the initial rate is 100%, the frame rate for the first trial, for a given frame length, is the
maximum rate for the topology and speed of the transmitting SmartCard.

Test progress 1 If all frames from the transmitting SmartBits port are received by the receiving port,
no further trials are attempted and the maximum frame rate is recorded as the through-
put.

2 If the first trial fails (if even a single frame is lost), the second trial frame rate drops to
20% lower than the failed rate.

3 The third trial and each subsequent trial uses a binary search to determine a rate that is
halfway between the last failed rate and the last successful rate.

4 The test finishes when the frame loss percent is less than or equal to the resolution

value in the test setup (depending on the interframe gap resolution of the card1).

Test results Test results are automatically logged to a file showing maximum data rate by port pair and
aggregate frame data rate. Also logged is the percentage achieved of maximum theoretical
frame data rate for each selected frame size.

This test is performed for a user-specified number of times and the results are averaged.

1. Refer to the SmartBits System Reference manual for information on the gap resolution of specific
cards and modules.
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Acceptable Loss Throughput
In some cases, differences in clock tolerances between the DUT port and the SmartBits
port will cause Throughput test results to show frame loss. This frame loss does not reflect
the capability of the switch or router, but rather is the result of these clocking variances.

To compensate for this, you can run a SmartApplications Throughput test in a mode
termed Acceptable Loss Throughput. When this mode is selected, you specify what
percentage of frame loss is to be discounted when evaluating the test’s success or failure.

If you enable Acceptable Loss Throughput (by setting a loss value), the SmartApplications
main window changes to show the alternate test mode (Figure 2-2). The Throughput Test
Results window and Test Report also include information on the acceptable loss
performance.

See “Set Up Test Configurations” on page 48 for details on setting values.

Figure 2-2. Throughput Test with Acceptable Loss

Throughput with Acceptable Loss enabled
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Latency Test Methodology
The Latency test measures latency as defined in RFC 1242, as described below for both
store-and-forward devices and bit-forwarding devices.

How SmartApps
calculates latency

The sending SmartCard sends a burst of frames at a user-specified frame size through the
DUT at a user-specified throughput rate. In the middle of the burst stream, it inserts one
frame with an identifying trigger (tag). The time when the trigger frame is fully
transmitted is the Transmit Timestamp. The time the receiving SmartCard recognizes the
trigger frame is the Receive Timestamp. SmartApplications calculates latency as:

(Receive Timestamp) minus (Transmit Timestamp) = Latency

Specifically, SmartApplications first measures the cut-through rate and then calculates the
store and forward rate with this calculation:

(Cut-through Rate) minus (Frame Bit Time) = Store and Forward Rate

The Latency test is performed at a user-specified frame rate.

Cut-through
(bit-forwarding)
latency
calculation

For cut-through device measurements, SmartApplications calculates latency as FIFO (first
in-first out), meaning that it calculates the difference between the time that the end of the
first bit of a transmitted frame reaches the DUT’s input port (Transmit Timestamp) and
the time the first bit of the same frame is seen on the DUT's output port (Receive
Timestamp).

If NA (“Not Applicable”) appears in either of the columns labeled S&F (Store &
Forward) in the test Results window, this is because the S&F calculation is zero or less,
indicating that the DUT is a cut-through device.

Store and
forward latency
calculation

For store and forward device measurements, SmartApplications calculates latency as
LIFO (last in-first out), meaning it calculates the difference between the time that the end
of the last bit of a transmitted frame reaches the DUT’s input port (Transmit Timestamp)
and the time that the end of the first bit of the same frame leaves the DUT’s output port
(Receive Timestamp).

Note:
1) It is recommended that you run the Throughput test before you run the Latency test in
order to obtain the optimum throughput rate of the DUT. Then use the throughput rate
obtained from the Throughput test for the Max Rate in the Latency test. Using a proven
optimum rate prevents the tagged frame from being lost due to performance rate issues. If
the tagged frame is not received, you may see a very large number for the RcvByte field of
the Log file.

2) SmartApplications always measures latency and yields results for both store and
forward devices and bit-forwarding (cut-through) devices regardless of the DUT. When
viewing results, use the result that is appropriate for your type of device.
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SmartMetrics
Compensation
Mode

This mode enables SmartApplications to render the same latency results as would be
produced by other SmartBits applications (such as SmartWindow) in SmartMetrics mode,
when the transmitter and receiver are running at different speeds.

With the option is disabled, the Latency test runs as usual, with the trigger pattern at the
usual offset in the frame. In this case, however, if the transmitter and receiver are running
at different speeds, the latency result will be different from what it would be in a
SmartMetrics test run through (for example) SmartWindow.

In contrast, when this option is enabled, the trigger pattern is offset to the same position in
the frame where the Signature field would be placed in a SmartMetrics test. As a result,
SmartApplications can produce the same latency result as a SmartMetrics application.

The SmartMetrics Compensation mode makes it possible to maintain continuity with past
results, when this is desired.

You can enable SmartMetrics Compensation Mode by selecting Setup > Test
Configuration from the main menu, the opening the Latency tab on the Setup Test
Configuration window.

Limits on Latency
Testing

The following limitation applies to latency tests using 10/100Mb cards in the SMB-200 or
SMB-2000. With these cards and chassis, the latency test duration is limited to 112
seconds when the packet size is 64 bytes and you are testing at 100% rate in the 100Mb
mode.

Use the SmartMetrics Compensation Mode
when you wish to make test results from
SmartApplications compatible with results
from SmartMetrics tests run using other
SmartBits applications, such as SmartWindow
or SmartFlow, when the transmitter and
receiver are running at different speeds.
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Packet Loss Rate Test Methodology
This test measures the percentage of frames lost by the DUT that should have been
forwarded, based on the total number of packets sent.

The Frame Loss Rate test satisfies the terminology criteria of RFC 1242 and the test
methodology specified in RFC 2544. From RFC 1242, Frame Loss Rate is:

“percentage of frames that should have been forwarded by a network device under
steady state (constant) load that were not forwarded due to a lack of resources.”

The test allows for varying frame sizes from 64 bytes to 1518 bytes for Ethernet ports, and
up to 8188 for Token Ring ports.

From RFC 2544, the methodology to measure frame loss is to:

“Send a specific number of frames at a specific rate through the DUT to be tested and
count the frames that are transmitted by the DUT.”

How frames are
counted

Frames are validated by counting only frames generated by the sending port, not any
packets sent by the switch. Keep-alive and routing update frames are not counted as
received frames.

How the test runs The Frame Loss Rate test operates in essentially the same manner as the Throughput test.

1 First a packet burst is performed at the maximum possible rate for a user-specified
period of time.

2 After all packets are sent, the receiving port is queried to determine how many packets
were received.

3 The number of packets not received is determined and the percentage of loss is calcu-
lated, based on the total number of packets sent.

Note: For Many-to-1/1-to-Many test configurations between ATM and Ethernet or ATM
and Frame Relay: If the DUT bundles multiple streams into one virtual circuit,
SmartApplications counters reflect the number of packets received on a per virtual circuit
basis (not per stream).

This test is performed a user-specified number of times and the results averaged.
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Back-to-Back Test Methodology
Back-to-Back tests the buffering capability of the device under test.

The Back-to-Back test satisfies the terminology criteria of RFC 1242 and the test
methodology specified in RFC 2544. From RFC 1242, the Back-to-Back test is performed
by:

“fixed length frames presented at a rate such that there is the minimum legal separa-
tion (maximum rate) for a given medium between frames over a sort to medium period
of time, starting from an idle state.”

The test allows for varying frame sizes from 64 bytes to 1518 bytes for Ethernet ports, and
8188 bytes for Token Ring ports.

From RFC 2544, the methodology to measure back-to-back frames is to:

“Send a burst of frames with minimum inter-frame gaps to the DUT and count the
number of frames forwarded by the DUT.”

How frames are
counted

Frames are validated by counting only frames generated by the sending port, not any
packets sent by the switch. Keep-alive and routing update frames are not counted as
received frames.

How the test runs The Back-to-Back test operates in essentially the same manner as the Throughput test.

1 First a packet burst is performed for a user-specified period.

2 If all packets are received at the receiving port, the test is successful and testing is
stopped.

3 If even one packet is lost, the number of packets sent in the burst is halved and retried.

4 If all packets are successfully received at this point, the packet burst is then chosen
halfway between the successful and unsuccessful trials, and retried.

5 This pattern repeats until the actual number of packets that can be forwarded in a burst
is determined.

This test is performed a user-specified number of times and the results are averaged.
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Install SmartApplications
It is assumed that you are familiar with Microsoft Windows and basic SmartBits
operation.

System Requirements
To run SmartApplications 2.50, you must have the following:

Hardware

• SMB-200
SMB-2000
SMB-600
SMB-6000B (formerly SMB-6000)

• At least two SmartCards or modules.

• IBM PC or 100% compatible.

• Pentium 200 or above.

• VGA video or better (recommended).

• 16 MB of RAM for Windows 95 / 98
—or—
32 MB of RAM for Windows NT.

• 10 MB free hard disk space.

Software

• Windows 95, Windows 98 or Windows NT 4.0 (see “Operating System
Requirements” below for detailed requirements).

• SmartBits Firmware 10.10 or higher.

• SmartApplications software.

Operating System Requirements

Operating System Version / Updates Required RAM (Mbytes)

Windows 95 B and C with current Service Packs
and library updates.

32

Windows 98 First and Second Edition. 32

Windows NT 4.0 Service Pack 6A. 64

Windows 2000 Professional Edition. 64
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Installing from the CD
SmartApplications is provided on one CD-ROM disk. To install the program, refer to the
instructions on the CD case.

Installation Using AutoPlay

AutoPlay (if enabled) will automatically begin the installation process.

1 Insert the SmartApplications installation CD in the CD-ROM drive. The Install Shield
window is displayed.

2 Select Install SmartApplications [Ver#].

3 Follow the instructions until all SmartBits software is installed.

If AutoPlay is Not Enabled

If AutoPlay is disabled or your PC does not support an automatic installation process, you
can use the following alternative procedure.

1 From the Start Menu, select Run.

2 When the Run dialog box appears, type:

<cd-rom drive>:\SETUP

—in the Command Line, then click OK.

3 Follow the instructions displayed as the installation program installs the software.

Launch SmartApplications
From the Start menu, select Programs > SmartBits Applications > SmartApplications.
The SmartApplications main window displays.

How to Close SmartApplications

To close SmartApplications, click the Close button at the top right corner of the screen.

or

Select File > Exit from the menu bar.
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Features of the Main Window
SmartApplications provides a dynamic main window that changes according to the
selections you make—for example, selecting a 1-to-Many or 1-to-1 test type.

Figure 4-1 highlights the key elements.

Figure 4-1. Main Window Elements

Connection Status

A connection status indicator (bottom right of main window) and the status message
Connected shows when SmartApplications is connected to the SmartBits. When
disconnected, the light is grey and the message Disconnected displays.

Menu Bar

Tool Bar

Connection

Test Launch
buttons

Port Selection
area

Card Attributes
area

status
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Menus

File Menu

These menu options allow you to create and manage configuration files.

• New
Opens the default SmartApplications test configuration (.sig) file. If you changed the
default values, this option allows you to reset the values to the defaults.

• Open
Opens a previously saved SmartApplications test configuration (.sig) file.

• Save
Saves the current settings as a .sig file.

• Save As
Saves the current test configuration under a new name.

• View Results File
Opens the Results window. Once the Results window opens you can view results for
the current configuration or for saved results for any previous configuration.

• Print
Prints the current configuration file.

• Print Setup
Allows the user to select the printer and setup printer options.

• [ path ]
Use this option to load a .sig (configuration) file that you defined and save previously.

• Exit
Closes SmartApplications.

Actions Menu

These menu options allow you to connect or disconnect to the SmartBits chassis.

• Connect
Establishes the logical connection from your PC to the SmartBits chassis.

• Disconnect
Breaks the logical connection from your PC to the SmartBits chassis.

Note: You define the connection type in the Setup SmartBits Connections dialog (select
Setup > SmartBits Connections from the main menu). You must first disconnect
SmartApplications from the SmartBits chassis to gain access this dialog.
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Setup Menu

Some of these options are active only when SmartApplications is disconnected from the
SmartBits chassis.

The Setup menu contains the following options:

• Test Configuration
Opens the Setup Test Configuration window. Use this to specify test parameters such
as test duration, learning packet information, and global test preferences.

• All SmartCards
Opens the Setup All SmartCards window. Use this to specify setup information for all
SmartCards from one window, instead of by individual card attribute tab, as well as to
make test-by-test or global changes (such as the speed) to all cards. You can also
access the Network IPs window and Token Ring Properties window from this
window.

• ATM Traffic Descriptor Type
Opens the Traffic Configuration window. Use this to specify call-setup broadband
capabilities and forward and backward traffic descriptor specifications.

• HTML Reports Setup
Opens the HTML Report Setup window. Use this when you wish to have test reports
generated in HTML format and to specify the report output path, filename, and
(optionally) comments.

• SmartBits Connections
Opens the Setup SmartBits Connections window. Use this to define the IP address and
TCP port number for IP network connections between SmartApplications and
SmartBits chassis, as well as to select either Serial (COM) port or IP as the active
connection type.

• SmartCards Reservation
Enables you to change the Reserved or Available status of slots when multiple users
are running tests on the same chassis.

Run Menu

The Run menu allows you to select one test to start running or to start all tests running in
succession. (You can also use the test launch buttons on the main window to start a test.)

• Throughput
Run the Throughput test (see “Throughput Test Methodology” on page 12).

• Latency
Run the Latency test (see “Latency Test Methodology” on page 14).

• Packet Loss
Run the Packet Loss test (see “Packet Loss Rate Test Methodology” on page 16).
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• Back to Back
Run the Back-to-Back test (see “Back-to-Back Test Methodology” on page 17).

• All
Run all four tests.

Help Menu

This menu contains two options:

• Contents
Opens SmartApplications online Help.

• About SmartApplications
Displays the current application version number, firmware number, SmartBits
Programming Library version used, and the serial number of the SmartBits controller.

From the About window, you can also access the SmartBits Controller and Card
Information window (below), It displays firmware version and other information for
the SmartBits chassis and installed cards. (You must have SmartApplications con-
nected to the chassis to have access to this window.)
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Launch Buttons
You can start any SmartApplications test by clicking on its launch button:

• Throughput

• Latency

• Packet Loss

• Back-to-back

You can also start individual tests by selecting Run > <test name> from the menu bar.

To run all tests in sequence, select Run > All.

Test Launch
buttons
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Toolbar Buttons

Table 4-1 Toolbar Buttons

Button Description

Opens an existing configuration file.

Saves the current configuration to a file.

Prints the current configuration file.

Connects SmartApplications to the SmartBits chassis. This allows you to display
the card attributes for the SmartCards in the chassis.

Disconnects SmartApplications from the SmartBits chassis.

Note: To set up IP or serial port connections, you must disconnect
SmartApplications from the chassis.

Displays the Setup SmartBits Connections window. Use this to set up IP and
serial (COM) port connections and to select the active connection type.

Displays the SmartCard Status window. Use this to check the status of cards and
to reserve or release ports in multi-user configurations.

Displays the Setup Test Configuration window. Use this to specify test
configurations and preferences.

Displays the Set Up All SmartCards window. Use this to configure the attributes
for all ports or multiple ports in one window.

Continues
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Button Description

Accesses the About SmartApplications window, which displays the current
application version number, firmware number, SmartBits Programming Library
number used, and the serial number of the SmartBits controller.

From the About window, click on Card Versions to obtain chassis and card
information, such as firmware version.

Table 4-1 Toolbar Buttons (continued)
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Port Selection Area
Use the Port Selection pane to specify the ports to be included in a test and the test type.

The test type may be 1 to 1 (one-to-one) or 1 to M (one-to-many).

Checking Bi-directional causes the selected port pairs to transmit simultaneously in both
directions, as in full-duplex operation.

Checking Reverse Tx & Rx port reverses the transmission direction, so that a Many-to-1
test can be run.

Selecting Ports for 1-to-1 Tests
1 Select the 1 to 1 radio button. The main window displays the 1-to-1 port selection pane.

2 Select at least one pair of Source and Destination ports.

3 Check Bi-directional if you want the selected port pair(s) to transmit and receive
simultaneously.

—or—

Check Reverse Tx & Rx port to reverse the transmission direction.
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Selecting Ports for 1 to Many Tests
1 Select the 1 to M radio button. The main window displays the 1 to M port selection pane.

Note: 1 to Many and Many to 1 tests are not compliant with RFC 2544.

2 Select the direction for the test using one of the direction buttons. The Source and
Destination fields will change locations depending on the direction you select.
Note: If you change the direction, the Destination MAC and SmartCard MAC
addresses on the card attributes tab remain unchanged. Ensure that you enter the
correct destination MAC address for the DUT.

3 Select Source card(s) and Destination card(s).

The last card that you select in the Source (Many to 1), or Destination (1 to Many) or
Available Ports field will be the card whose attributes appear as the second tab, as
illustrated in this Destination Index example:
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Charting Test Results
Once a test has finished running, you can present the results of the test in graph form. You
can create a wide variety of charts to graphically represent test results by using the Chart
Wizard. Charts range from 2D or 3D pie and bar charts to Gantt charts. You can also
customize titles, layouts, legends, and axes. The Chart Wizard is a separate charting
facility provided with SmartApplications.

Note: To understand how a test derives the results that are shown, refer to the appropriate
description of test methodology in this manual. See Chapter 2, “Basic Test Theory” and
the section for the test you are running.

To create a chart from the appropriate Results window tab do these steps:

1 Select the rows and columns you want to appear on the chart. To do this, click on the
first cell and then hold down the Shift key and click on the last cell to include. The
block of cells will be highlighted.

2 Click the Create Chart button to display the Chart Wizard.
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3 Select the type of chart you want to create from the Chart Wizard. The chart will be
attached to the spreadsheet.

4 Double click on the outside of the chart to access the Format Chart window and cus-
tomize the format.

For more information about how to use the Chart Wizard, refer to the Chart Wizard's
online help user guide. To access the online Help click the Help button from the Chart
Wizard window. The online Help system is called First Impression.
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In this chapter...

This chapter contains the following sections:

• Summary of Steps to Set up a Test.....36

• Connect the Device Under Test.....36
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• Select Test Ports.....60
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Summary of Steps to Set up a Test
Here is a brief overview of the steps to set up SmartApplications tests. See the following
sections for detailed procedures.

Note: If you are testing a router, you must check the Router Test box at the Test Setup
window Preference tab.

Connect the Device Under Test
If possible, connect the same-numbered ports on the SmartBits and the device under tests
(DUT). That is, connect SmartBits port 1 to DUT port 1, port 2 to port 2, and so on.

To verify that the cable is connected correctly, check that the device link light is on.

Note: For complete information about setting up the hardware and your SmartBits
chassis, refer to the related Installation manual and to the SmartBits System Reference
manual.

Step Task Refer to: Page

1 If running SmartApplications for the first
time, set up the communications port
between the PC and the SmartBits chassis.

“SmartBits Connection Setup” 37

2 Set up the test configuration and preferences. “Set Up Test Configurations” 48

3 Select the ports for the test(s) and the traffic
direction.

“Select Test Ports” 60

4 Configure the ports. “Configure Test Ports” 67

5 Run the test. Chapter 6, “Run Tests” 125

6 Review test results. Chapter 7, “Test Examples” 151
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SmartBits Connection Setup
SmartApplications needs to know the communications port your PC is using to connect to
the SmartBits chassis. To define this, select Setup > SmartBits Connections... from the
main menu.

Note: The SmartBits Connections option is active only when SmartApplications is
disconnected from a SmartBits chassis. Connection status is shown on the status bar.

The SmartBits Connections dialog enables you to manage both serial and IP connections.

• Serial
(Default) For point-to-point connections. See “Connect Using a Serial Port” on page
38 for more information.

• Ethernet
Requires a network card in your PC, and a SmartBits chassis with Ethernet
capabilities (SMB 200/2000 or SMB-600/6000B. Allows you to run
SmartApplications over an Ethernet connection (including the Internet) from your PC.
See “Connect Using an Ethernet Port” on page 40 for more information.

Use this pane to define
new connections.

The Connection List displays all
connections that are already defined.

Click to move up or down in the list
or to delete an entry.
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Connect Using a Serial Port
Use the following steps to set up a serial (COM) port connection between the PC and the
SmartBits chassis.

1 Choose Setup > SmartBits Connections...

2 In the Add SmartBits Connections pane, click the Serial radio button.

3 In the Comm Port list, select the COM port you have used to connect the PC to the
SmartBits.

By default, the selected port is COM2 at 38400 bps. The list shows only available
COM ports. If the list does not include an installed COM port (for example, COM1),
this may be caused by the following:

• You have a serial mouse connected to that port.

• The port is opened by another currently running program.

4 Use the Speed list to select the baud rate for the port.

SmartBits supports connections up to 38400 bps (the default). Some PCs may have
trouble keeping up with baud rates above 9600 bps. SmartApplications attempts to
connect to SmartBits at all possible baud rates, then sets the final baud rate to the rate
selected.

5 Optionally, use the Description field to define a name for the connection.

6 Click Add.

The new entry appears in the Connection List.
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Serial Connection Problems

If SmartApplications cannot establish the serial-port communication link, some
troubleshooting may be required. Refer to your SmartBits 200/2000 Installation Manual
or SmartBits 600/6000B Installation Manual for detailed information on the possibilities
listed below.

• An invalid COM port was selected from the drop-down Comm Port list in the Setup
SmartBits Connections dialog. The COM port may already be in use by another
Windows application, or there may not be hardware available to support it. In this
case, try another COM Port.

• The wrong type of cable was used to interconnect the PC and the SmartBits chassis.

Ensure that the RS-232 cables connecting the PC serial port to the SmartBits chassis
(as well as any succeeding SmartBits chassis) are properly chosen, connected, and ter-
minated. Ensure that cable is not a null modem cable.

• The port is configured incorrectly. Ensure that the Speed setting in the Setup
SmartBits Connections dialog is consistent with the baud rate on the SmartBits
chassis.
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Connect Using an Ethernet Port
A configured SmartBits chassis has an IP address that was set either through:

• SmartWindow or HyperTerminal for the SMB 200/2000

• HyperTerminal for the SMB 600/6000B.

This enables you to connect to the SmartBits by using an Ethernet network connection.

Note: Refer to your SmartBits 200/2000 Installation Manual or SmartBits 600/6000B
Installation Manual for the steps to assign the IP address.

Use the following steps to define the IP address in SmartApplications. You can control up
to 16 different chassis from one SmartApplications instance (and can define many more IP
addresses, if necessary).

1 Choose Setup > SmartBits Connections...

2 In the Add SmartBits Connections pane, click the IP radio button.

3 Set the IP address of the SmartBits chassis. The factory assigns the TCP port number
16385 to the chassis.

4 Optionally, use the Description field to define a name for the connection.

5 Click Add.

The new entry appears in the Connection List.
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Making the Connection
Once you have set up the connection type, you are ready to connect SmartApplications to
the SmartBits chassis.

1 Choose Actions > Connect, or click on the Connect SmartBits button on the toolbar.

The SmartBits Connection Confirmation dialog lists all the connections that are cur-
rently selected (checked in the Setup SmartBits Connections dialog).

SmartApplications will try to connect first using the 1: link or address in the list. If it
cannot establish that connection, it tries the 2: entry, then following entries (if neces-
sary).

2 If connection is successful, the Connected indicator appears in the lower right corner
of the main window. If Disconnected is shown, SmartApplications is not connected.
In this case, review all connections for conformance with instructions in your Smart-
Bits Installation manual.
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Linking Multiple SmartBits Chassis
You can connect multiple controlling SmartBits chassis by assigning each controlling
chassis an IP address, as shown in Figure 5-1.

Figure 5-1. Numbering Stacked and Daisy-chained Chassis

Rules for Selecting Hub/Slot/Port Configurations

To understand hub/slot/port designations in SmartApplications, keep these rules in mind:

• You can link a maximum of 16 chassis across, each with a unique IP address or COM
port.

• You can stack SMB-2000 chassis in arrangements of up to four individual chassis.
The top hub in the stack must be an SMB-2000. The bottom three chassis may be
SMB-2000s or SMB-10s.

Note: You cannot stack SMB-6000B, SMB-600, or SMB-200 chassis.

• When you link SmartBits chassis, four real or virtual hubs are allocated to each IP
address (for each chassis linked across; see Figure 5-1). Space is reserved for these
hubs whether or not physical chassis are actually installed with the first (master) hub.

• The number of ports per slot depends on the type of card installed in the slot. The
maximum configuration for a SmartBits chassis stack is 96 ports. This results in a
theoretical maximum port capacity of 1536 ports per SmartBits chain (16 SMB-
6000B chassis each populated with 96 ports).
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• Hub/slot/port information appears in port selection dialogs and window, and in test
reports. Information displays in the format [xx,xx,xx]. For example, [05,04,03]
represents hub 5, slot 4, port 3.

• The arrangement of hub/slot/port information in the connection list is based on the
order in which IP addresses are arranged on the list. For example, with the chassis
illustrated above, the IP address for Hub 13 (192.106.1.13) is listed fourth in the
connection list. If this IP address had been listed first, Hub 13 would be Hub 1. The IP
address listed next would then become Hub 5, and so on.

Synchronizing Clocks in Local or Remote Chassis

You can synchronize the clocks in multiple SmartBits that are local to one another or
remote from each other. Doing this enables you to start and stop tests simultaneously at
the SmartBits chassis. Local synchronization is done through cable interconnections.
Remote synchronization makes use of a GPS (Global Positioning System), which
becomes the clock source for each chassis, providing each SmartBits with an atomic
clock.

Local
synchronization

For the steps to synchronize local chassis, refer to your SmartBits Installation Manual.

Remote
synchronization

For information on how to set up the GPS receiver, including cabling information, refer to
the Application Note #15 — Using GPS with SmartBits. It accompanies the GPS unit.

Note: Before running a latency test between two remote SmartBits chassis in GPS mode,
endure that the GPS receiver has been on for several hours. This is necessary for the GPS
receiver components to be locked on. If you fail to do this, SmartApplications may send
error messages.

Multi-User Access
If a SmartBits chassis is multi-user-capable, it allows up to ten users to connect
simultaneously. When SmartApplications is connected to a multi-user chassis, it lists the
installed cards and shows their current status as either Reserved or Available. You must
reserve a card to be able to use it in your test.

An SMB-6000B chassis is always capable of multi-user connections. An SMB-2000
chassis must display a Multi-user Ready identifying sticker to be multi-user capable. The
SMB-200 is a single-user-only chassis.

On an SMB-2000, the multi-user sticker indicates that:

• An SMB-2000 multi-user-compliant backplane is installed.

• Chassis firmware 6.50 or later is installed.

Note: Any SMB-2000 chassis can be factory-refitted to become multi-user compliant.
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Reserving Cards
In a multi-user test environment, you must reserve cards or modules before you can use
them in tests. To do this:

• Check card status.

• Reserve available cards for your use.

• When done, release the cards.

To check card status:

To check the card availability:

• Click the Reserve/Release SmartCards toolbar button on the SmartApplications
main window.

—or—

• Select Setup > SmartCard Reservation.

The SmartCard Status window displays information like that shown in Figure 5-2 on
page 44.

3 Click the tab for the controller (chassis) you wish to view.

Each controller tab shows the hub, slot, and number of each port, the card model number,
and the status of the port: Reserved or Available. In the Hub column, a blue light indicates
Reserved, and a green light indicates Available.

Figure 5-2. SmartCard Status Window
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To reserve cards:

To reserve an available card from a controller tab in the SmartCard Status window:

1 Click on the port you wish to reserve to highlight it.

2 Click Reserve.

SmartApplications automatically updates the controller field to show your selection.
You can also click Refresh to update the field.

3 When you are finished reserving cards, click Close.

To release cards:

To release a card you have reserved:

1 Open the appropriate controller tab in the SmartCard Status window.

2 Click on the port you wish to release to highlight it.

3 Click Release.

SmartApplications automatically updates the controller field to show your selection.
You can also click Refresh to update the field.

4 Click Close when finished.
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Starting and Stopping a Test
The remainder of this chapter describes how to set up test configurations to use in testing
(see “Set Up Test Configurations” on page 48 and following).

To start a test:

Once you have set up test parameters and selected the ports to test, you can start the test in
several ways:

• Click the appropriate launch button on the main SmartApplications window

• Select Run from the menu bar.

To start one or more tests automatically:

You can set one or more tests to run automatically each time you launch
SmartApplications.

1 Select Setup > Test Configuration.

2 Open the Preference tab, the use the Application Options pane to select the tests you
wish to run.

The next time you open SmartApplications, the selected tests will begin running
automatically.
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Note: If you check Stop on Error in the Test Options pane of the Preference tab, the test
will stop running when it encounters an error conditions (for example, Latency packet not
received).

If you want the test to continue to run regardless of errors, leave this option unchecked.

If you plan to run a long test, we recommend that you do not check this option.

To stop a test:

To stop a test that is running, click the Stop button in the Results window.

Click the Stop button in the Results window to halt a test.
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Set Up Test Configurations
To set up test configurations:

1 Select Setup > Test Configurations from the main menu.

2 Use the Test Configuration tab Figure 5-3) to set options for tests.

Figure 5-3. Test Configuration Tab with Test Options

Note: Remember that SmartApplications enables you to save test configurations to a file
for future use. See “File Menu” on page 25 for options.

The Setup Test Configuration dialog includes two tabs:

• Test Configuration See “Test Configuration Options” on page 49

• Preference See “Preference Tab” on page 55
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Test Configuration Options
The Test Configuration tab (Figure 5-4) includes panes to define General test parameters;
the handling of Learning Packets; and individual test parameters.

Figure 5-4. Setup Areas on the Test Configuration Tab

General Options
Use the fields in the General pane to specify the range of packet sizes to be transmitted
during the test. Standard packet sizes are in multiples of 64 bytes. (Click on Sizes to view
the list of standard sizes.)

Tests do not necessarily run until the maximum (Stop At) packet size is sent. If the Step
Size value increments the packet size to a value larger than the Stop At value, the test stops
at the Stop At value. For example, if you set the fields as follows:

Start From 64

Stop At 200

Step Size 64

—the test will send packets of 64, 128, and 192 bytes, then stop. It will not send 256-byte
packets (larger than Stop At), and will it not send 200-byte packets (not in the Step Size
increment sequence).

General test

Learning

Individual test
parameters

packets

parameters
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Start From Enter or select the size of the smallest packet to send. The default size is 64 bytes.

Stop At Enter or select the size of the largest packet to send. The default size is 1518 bytes.

Step Size Enter or select the number of bytes that the current packet size will be incremented with
each test. For example if the step size is 10 bytes, the first test transmits packets that are 64
bytes, and the next test transmits packets that are 74 bytes.

Use Custom Unchecked
Runs tests according to settings in the Test Configuration tab.
Default custom sizes are: 64, 128, 256, 512, 1024, 1280 and 1518.

Checked
Runs tests according to the packet sizes specified at the Custom Packet Sizes window.
Enables the Sizes button.

Setting an
Acceptable Loss
Percentage

If you select Use Custom, you can set a level of acceptable frame loss for each frame size
sent during the test. (See “Acceptable Loss Percentage (%) (per port)” on page 53 for an
explanation of this option. Also see “Acceptable Loss Throughput” on page 13 for a
general description of this option for Throughput tests.)

Click on Sizes. In the Custom Packet Sizes window, use the Acceptable Loss (%) column
to set an acceptable level of frame loss for each frame size, as needed for your test.

Figure 5-5. Setting Acceptable Loss for Custom Packet Sizes

Use the Acceptable Loss (%) column to specify what
percentage of frame loss should be discounted during
each trail of a Throughput test.
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Learning Packets Options

Learning packets are used by the DUT to build its forwarding tables of MAC addresses for
the sending and receiving SmartBits ports. You can send cause learning packets to be sent
once for the test or between every test trial, to refresh the DUT’s forwarding tables before
addresses are eliminated by aging.

Learning Mode Select the mode by which SmartApplications sends out learning packets to update the
device's forwarding tables. Possible modes:

Never
Never send learning packets to the device under test.

Once
Send learning packets once at the beginning of each test. For example, if you select packet
sizes of 64 and 128 bytes, SmartApplications sends learning packets before the 64-byte
test and again before the 128-byte packet test.

Every Trial
Send learning packets before each trial. For example: You wish to test at a packet size of
64 bytes, starting at 50% and incrementing 10% each trial. Learning packets will be sent
before the 50% trial, before the 60% trial, and so on.

Learning
Retries

Enter or select the number of times SmartApplications should retry sending learning
packets before it starts the actual test. Some devices require more packets to learn an
address. This value is used to loop on the transmission of the learning packets. There is a
one-second delay between retries.

Note: If the DUT shows signs of flooding during testing, consider increasing the default
values in the Learning Packets pane or increasing the aging timer in the DUT.

Individual Test Options

Open the tab for each test that you want to run and set test parameters.

Duration (sec) Enter or select the length in seconds for which you want to run each trial of the test. It is
the amount of time that SmartBits will send data for each packet for the selected test.
Possible values range from 1 to 999 seconds.

Note: For 100Mb cards, do not use a value greater than 110 seconds, or
SmartApplications will send the error message “Parameter out of range.” when you run
the test.
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Number of
Trials

Enter or select the number of times that you want SmartApplications to repeat the selected
test(s). Values range from 1 to 25 for each packet length. After all tests, SmartApplications
averages the results before reporting a summary of all trials for each test.

Initial Rate (%) The rate at which packets will be transmitted at the start of a trial.

Step Rate (%) Does not apply to the Throughput test.

The percentage that the test increments with each trial. Step rate specifies how quickly the
test rate will increase after a trial finishes. Select or enter an integer or decimal value. The
minimum decimal value you can enter is .1.

Min. Rate (%) Does not apply to Latency tests.

The rate at which transmission trials will stop. Select or enter an integer or decimal value.
The minimum decimal value you can enter is .1.

Max. Rate (%) The maximum rate at which each packet size should be transmitted. Select or enter an
integer or decimal value. The minimum decimal value you can enter is .1.

When selecting this rate for the Latency test, the Latency measurement should be at the
rate where the Throughput test passed. Setting a value of 100% may not be measuring the
true latency of your device under test. Set this value accordingly. For example, if you
know a particular device cannot exceed 90% of wire speed, set the maximum to 90% to
save time.

Note: Run the Throughput test before the Latency test to obtain the DUT’s maximum
throughput rate. Then use that throughput rate for the Max Rate in the Latency test. Using
a proven rate prevents the tagged frame from being lost due to rate (gap size) issues.

Resolution (%) Applies only to the Throughput test.

Resolution determines the exactness of the test result. Lower settings yield a more precise
result but usually results in longer test times.

How Resolution Affects Test Progress

If you set the resolution to 2%, testing will stop when the difference between the last
successful test and the last unsuccessful test is less than 2%. If the initial trial failed at
100%, the second trial might run at 50%. Assuming no packets were dropped at 50%, the
next trial would increase to 75%. Again assuming no lost packets, the rate of the next trial
might increase to 87.5%, and so on. Eventually, you might run a trial at 98.2%. Since the
resolution was set to 2%, testing would stop here, because 100 – 98.2 is 1.8%, which is
less than 2%. If the resolution had been set to 1% another trial would be run, since 1.8% is
greater than 1%.
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Acceptable
Loss
Percentage (%)
(per port)

Applies only to the Throughput test.

This option provides a way to compensate for frame loss caused by differences in clock
tolerances at the DUT port and the SmartBits port. Such variances in clocking can cause a
Throughput test to show frame loss that is caused not by the operation of the switch or
router, but rather by these discrepancies in clock timing.

When you select Acceptable Loss Percentage (per port), the Throughput Test launch
button on the SmartApplications main window changes to show the selected mode
(Figure 5-6). The test result reports also show how the specified acceptable loss has
figured into the test (see “Sample Reports – Throughput Test” on page 137).

Figure 5-6. Throughput Test Launch Button with Acceptable Loss Enabled

SmartApplications considers the last trial a success if frame loss did not exceed the
specified percentage. The test then continues according to the settings of other test
options, such as Number of Trials and Resolution (%).

Setting
Acceptable Loss
for each frame
size

When you set a value to this option, the percentage applies to all frame sizes generated
through the port for the test. You can also specify an acceptable loss percentage for each
frame size sent during the test. To do this, select Use Custom in the Test Configuration
window, then click on Sizes to open the Custom Packet Sizes dialog. Use that dialog to set
a percentage value for each frame size, as desired (see “Use Custom” on page 50).

Throughput with Acceptable Loss has been selected.
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Customizing Test Packets
You can select packet sizes other than the standard by selecting Use Custom on the Test
Configuration tab. Click Sizes to open the Custom Packet Sizes dialog (Figure 5-7).

Figure 5-7. Custom Packet Sizes Dialog

The default values are the seven packet sizes specified for Ethernet testing in Section 9.1
of RFC 1242.

To change the
number packet
sizes:

Enter or select a new value in the Number of Sizes field. The maximum number of packet
sizes is 25. To enter a custom value for a packet size, click on a Packet Size field and type
in a value.

Click OK to close the window and make your selected sizes the current settings.

Click Cancel to close the window without making changes.

Click Default to revert to the seven default packet sizes.

Setting
Acceptable Loss
(%) per frame
size

Use the Acceptable Loss (%) column to specify what degree of frame loss should be
discounted, for each frame size, when running the test.

See “Acceptable Loss Percentage (%) (per port)” on page 53 for an explanation of this
option, as it applies to all frame sizes generated during the test.
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Preference Tab
Use the Preference tab of the Setup Test Configuration window to report filenames and
other application or test options.

Select Setup > Test Configuration from the menu bar and click the Preference tab.
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Preference Tab Fields

Table 5-1 describes the fields on the Preference tab.

Table 5-1. Preference Tab Fields.

Pane Field Description

Application Options Start Throughput Check to start this test automatically when you start
SmartApplications.

Start Latency Check to start this test automatically when you start
SmartApplications.

Start Packet Loss Check to start this test automatically when you start
SmartApplications.

Start Back to Back Check to start this test automatically when you start
SmartApplications.

Create Tabular
Report

Check to generate reports in tabular format with results by
packet size running horizontally across the page. Uncheck if
you want to use the non-tabular format.

Connect to SmartBits
at Startup

Check to automatically connect to the SmartBits chassis
when SmartApplications starts. This speeds up application
startup time.

Test Options Router Test Check if you are testing a router. This enables the Next Hop
Test checkbox.

Stop On Error Checked: When errors are encountered, the test stops and
error messages display, to enable you to correct the
condition.

Unchecked: Errors are ignored and the test continues. Error
messages are logged to the results file. Leave this box
unchecked if you want the test to run regardless of error
conditions.

Next Hop Test Enables you to test the Next Hop gateway address.

Disable ET Display Checked: The SmartBits does not try to track updates for
the front panel of an attached ET-1000.

Unchecked: Uncheck only if your test bay includes an ET-
1000 controller and you want to track ET-1000 counters
through the front panel display.
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Test Options
(continued)

Tear down ATM
connection every
frame size test

When testing ATM cards, disconnect the stream and
connection for each trial.

VPI-VCI Hex Format When testing ATM cards, check to view VPI and VCI
values in hex format.

Offered (actual) Load You can run each test using either an “Intended” method of
loading the device under test (DUT) or an “Offered Load”
method of loading the DUT.

Checked: “Offered Load” method is enabled.

Unchecked: “Intended” method is enabled.

See “Offered vs. Intended Load” on page 58 for further
information on this option.

Note: On LAN-3300A/3301A modules, the Latency test is
not supported when Offered Load is enabled (checked). To
run the Latency test with these modules, disable this option.

Keep Frame Relay
PVC Active between
Trials

When testing ATM cards, check to prevent the teardown of
the PVC between tests (when changing from one packet
size to the next) or between trials (changing from one frame
rate to the next).

Delay After Transmit Select the number of seconds to wait after all Tx cards have
finished transmitting.

SmartCard
Reservation Options

— Select the option for reserving or releasing cards in multi-
user environments. You can elect to reserve one to all cards
throughout the session, or no cards, when you connect to a
multi-user chassis.

Optionally, specify a reservation timeout by using the
Minutes field. If you do this, the timer starts each time you
connect. If the timeout occurs, all reserved cards are
released.

Report Filenames
(no file extension)

— You can accept the default filenames for test results (as
shown in the field for each test) or specify a different
filename.

Table 5-1. Preference Tab Fields.

Pane Field Description
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Offered vs. Intended Load
You can run any test using either an Intended method of loading the device under test
(DUT) or an Offered Load method of loading the DUT. The Offered (actual) Load
checkbox on the Preference tab selects the method. When checked, the “Offered Load”
method is enabled (default). When unchecked, the “Intended” method is enabled.

The Intended transmit rate is derived by calculating the number of frames per second,
based on configured load, for the duration of the test.

Offered Load is supported in SmartApplications 2.50 and later. It takes into account the
possibility that flow control from the DUT may cause the transmitting SmartBits port to
send fewer frames than attempted—for example, because the port is held off by Pause
commands from the DUT. When Offered Load is selected, performance measurements are
based on this actual transmit rate (“Offered Load”). In previous versions, measurements
were based on the derived (“Intended”) rate. Here, “derived” and “intended” refer to the
rate attempted based on the configured frame size and rate, with respect to the line rate.
Because Offered Load reflects the actual transmit rate, the resulting performance
measurements may be considered “more accurate” than those obtained by using the
“Intended” method.

Note: Latency tests are not supported on the LAN-3300A/3301A modules when Offered
(actual) Load is enabled. To run Latency tests with these modules, disable Offered
(actual) Load.

Use this checkbox
to select how the
DUT should be
loaded during the
test: by either the
“Intended” method
or “Offered Load”
method.
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Saving a Test Configuration
You can save your test configurations in a .sig file. Doing this can save considerable
time—for example, in editing protocol header fields—and it is highly recommended.

To save your test setup to a file

Select File > Save As and enter the file name.

The last saved configuration becomes the default configuration for any future tests.

To load the file later

Select File > Open and select the file.
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Select Test Ports
In any test, one or more source ports generate traffic to the device under test (DUT), and
one or more destination ports receive and check the frames received from the DUT. You
must select at least two ports for any test: one source port and one destination port.

The port configuration needed for a test depends on its type:

• 1 to 1 tests use only port pairs.

• 1 to Many tests use a single source port and multiple destination ports.

• Many to 1 tests use a multiple source ports and one destination port.

For any test type, you use the arrow buttons to add and remove ports from the port lists. At
startup, SmartApplications queries the SmartBits to determine what cards are installed,
and it lists them in the Available Ports list box.

Use the arrow
buttons to add and
remove ports from
the port list for a
test.
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Hub, Slot, and Port Numbering
When you connect SmartApplications to a chassis, the Source and Destination port lists
identify the installed ports in the “hub/slot/port” format. These three values are:

Hub# The SmartBits chassis number (in multi-chassis setups).

Slot# The slot where the card or module is inserted.

Port# The port on the card or module.

For all three values in the hub/slot/port triplet, numbering starts at 01.

Note: Slot numbers increment sequentially whether or not ports are physically installed.

SMB-200/2000 Port Numbering

The SMB-200 and SMB-2000 chassis accept single-width cards with one port, as well as
double-width cards with one to four ports. Each slot is numbered on the chassis, and on
multi-port cards each port is numbered on the card face.

Refer to “Linking Multiple SmartBits Chassis” on page 42 for additional information.

SMB-600/6000B Port Numbering

The SMB-600 and SMB-6000B chassis accept modules with one to eight ports.
Each module slot is numbered on the chassis. The two modules that occupy each slot are
designated A and B, with the A module on the left and the B module on the right.

Ports are numbered from left to right on the module face.

Refer to “Linking Multiple SmartBits Chassis” on page 42 for additional information.

Allowed Port Pair Combinations
You can use SmartApplications to test mixed topologies or matched topologies.

Table 5-2 and Table 5-3 list the possible combinations of card types for the 1 to 1 test and
the 1 to Many/Many to 1 test.
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1 to 1 Test: Allowed Card Combinations

The 1 to 1 test topology provides results for all four tests, using all currently available
cards and modules, with exceptions listed below.

Table 5-2. 1 to 1 Tests: Allowed Card (Port-pair) Combinations

TO

FROM Ethernet Token Ring ATM WAN

Ethernet Y Y1

1 Router testing only.

Y2

2 Ethernet to ATM supports all four tests using LANE 1.0 SVCs or Classical IP PVCs.

Y3

3 Frame Relay cards support only one DLCI.

Token Ring Y1 Y N Y

ATM Y4

4 ATM to Ethernet does not support Latency or Back-to-Back tests. Throughput and Packet
Loss tests are supported, but only using LANE SVCs or Classical IP PVCs.

N Y5

5 ATM to ATM supports Throughput, Packet Loss, and Latency tests, for router or ATM
switch testing. The Back-to-Back test is not supported. Latency measurements are based on
the first frame in the burst, not the frame in the midst of the burst.

Y1,6

6 ATM to Frame Relay supports only the Throughput and Packet Loss tests, and you must use
Classical IP PVCs.

WAN Y3 Y Y1,3,7

7 Frame Relay to ATM supports all tests, and you must use Classical IP PVCs.

Y3
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1 to Many/Many to 1 Test: Allowable Card Combinations

The 1 to Many/Many to 1 test topology provides results only for the Packet Loss and
Back-to-Back tests, using all currently available cards and modules, with the exceptions
listed below.

Notes:

ATM to Ethernet or ATM to WAN:
If the DUT bundles multiple streams into one virtual circuit, SmartApplications counters
reflect the number of packets received for each virtual circuit (not per stream).

WAN Cards:
WAN ports may be used only on the “many” side of a 1 to Many/Many to 1 test topology.
They may not be used on the “one” side.

Table 5-3. 1 to Many/Many to 1 Tests: Allowed Card Combinations

TO

FROM Ethernet Token Ring ATM WAN

Ethernet Y Y1

1 Router testing only.

Y2

2 Ethernet to ATM supports all four tests using LANE 1.0 SVCs or Classical IP PVCs.

Y3

3 Frame Relay cards support only one DLCI.

Token Ring Y1 Y N Y

ATM Y4

4 ATM to Ethernet does not support Latency or Back-to-Back tests. Throughput and Packet
Loss tests are supported, but only using LANE SVCs or Classical IP PVCs.

N Y5

5 ATM to ATM supports the Packet Loss test for PVC CLIP only.

Y6

6 Router testing only, with ATM to Frame Relay using PVC CLIP only.

WAN N/A N/A N/A N/A
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Running 1 to 1 Tests
The 1 to 1 test sends test traffic between port pairs: from source port to destination port.

To run a 1 to 1 test:

1 Click the 1 to 1 radio button.

2 Select a port number from the Source list box, and another port number from the Des-
tination list box.

3 With both ports highlighted, click the > button to add the port pair to the Test Pairs
list box.

4 Select Bi-directional to cause the selected port pairs to transmit simultaneously in
both directions, as in full-duplex operation.

Note: When you run bi-directional Latency tests, SmartApplications determines results
for only one direction. For example, if you select source Port 1 and destination Port 3, the
results would reflect the Port 1 to Port 3 direction only.
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Bi-directional Traffic

Checking Bi-directional causes the selected port pairs to transmit simultaneously in both
directions, for full duplex implementations. This option (available only for 1 to 1 tests) is
not recommended when the transmitting and receiving cards have different link speeds
and/or network topology.

As an example, if you test a router using a port pair made up of one Ethernet port and one
ATM port, bi-directional results would not be meaningful, because the percentage of
traffic offered on each side would not be equal.

Bi-directional tests in half-duplex mode: Performing bi-directional throughput tests in
half-duplex mode at high rates will result in line collisions. Excessive collisions will
effectively increase the total transmission time which may render the test results invalid.
When this occurs, throughput is calculated based on the intended load as opposed to the
actual offered load.

Bi-directional Latency tests: When you run bi-directional Latency tests,
SmartApplications determines results for only one direction. For example, if you select
source port 1 and destination port 3, the test results will reflect only the port 1-to-port 3
direction.
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Running 1 to Many/Many to 1 Tests
The 1 to Many test sends test traffic from one port to many ports. The r Many-to-1 test
sends test traffic from many ports to one port. With a 1 to Many configuration, only
Packet Loss and Back-to-back test results are available.

To run a 1 to Many or Many to 1 test

1 Click the 1 to M radio button.

2 Click a direction button to select one port to many, or many ports to one.

3 Select one or more ports from the Available Ports list box. and click the < button. The
ports appear in the Source or Destination list box, depending on the direction you
select. (The figure above shows the Destination box.)

If you change the test direction, the Destination MAC and Source MAC addresses
shown in the card attributes tab remain unchanged. Ensure that you enter the correct
destination MAC address for the DUT (see figure).

For configurations between ATM and Ethernet or ATM and Frame Relay: If the
DUT bundles multiple streams into one virtual circuit, SmartApplications counters reflect
the number of packets received on a per virtual circuit basis (not per stream).

Direction
buttons

MAC addresses on
card attributes tab
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Configure Test Ports
You can configure the SmartBits test ports in two ways:

1 Configure ports individually by using the port attribute tabs in the main window.

2 Configure multiple ports by selecting Setup > All SmartCards and using the Setup
All SmartCards window. This is a faster and more convenient method if your test will
include many ports, because it allows global changes.

SmartApplications stores the last four setup configuration (.sig) files that were used in a
SMARTAPP.INI file in your Windows directory. Each time you open SmartApplications,
the last configuration file is recalled automatically.

You can configure test ports
individually, by using the
port attributes tabs in the
main window.

Or, select Setup > All
SmartCards to configure
all ports (or multiple ports)
at one time.
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Configuring Multiple Ports at Once
You can use the Setup All SmartCards window to configure the attributes for multiple
ports. Select Setup > All SmartCards from the SmartApplications main window:

Changing Cell Values

Certain cells are locked and their field values cannot be modified. These fields are
highlighted in yellow in the Setup All SmartCards window.

To modify unlocked cells, use the following steps, depending on field type.

To modify Speed, Duplex, and Protocol fields:

1 Click on a cell to outline it.

2 Right click on the cell to display the popup menu and select a value.

Note: On LAN-3300A/3301A modules:

• Half-duplex currently is not supported.

• When selecting speed values, High specifies Gigabit (1000Mbps), Low speci-
fies 100Mbps. To set 10Mbps, use the card attributes tab.
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To modify Destination MAC and IP/IPX fields:

To modify these fields:

• Destination MAC

• SmartCard’s MAC

• SmartCard’s IP/IPX

• Router’s IP/IPX

1 Click on the cell.

2 Enter the new value.

To modify the *Net IPs/+Ring field:

1 Click on the cell to highlight it.

2 Right click on the cell to display the popup menu.

3 Select * Network IPs to open a popup menu and modify the Network IPs for Next
Hop tests.

4 Select + Ring Properties to open a popup menu and modify values for Token Ring
networks.

If either Network IPs or Token Ring does not apply to the port, the option is greyed out on
the popup menu.

To change all the field values in a column

You can change a field value globally for all ports.

Note: You must specify MAC and IP fields individually by port.

1 Click the column header to highlight the entire column.

2 Right-click on the header. A popup show available options.

3 Select an option. All cells in the column change to the selected value.
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Configuring a Ports Individually
You can configure ports individually by using the port attributes tabs in the main window.
Each tab displays options appropriate to the network topology of the selected port (see the
following sections for descriptions of options).

1 Select the ports for the test from the main window (if not yet done). The tabs display
the two ports (source and destination) you selected last.

Note: Ensure that these are the ports you wish to use in your test.

2 Select each tab in turn, and define the following:

• MAC addresses. For routers, this is the MAC address of the local router port. If
you are doing 1 to Many/Many to 1 tests, you must define addresses for each card
in the test.

• All other information relevant to the selected port type, such as:

– Next hop network IPs for Next Hop tests.

– Token Ring properties for Token Ring cards.

– Line and ELAN parameters for ATM cards.

– Line or LMP or Address information for WAN cards.

Use the port attributes tabs
to configure test ports one
by one.
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Configuring Ethernet Ports
When you select an Ethernet port, the port attribute tab displays Ethernet setup options.

Note: For Ethernet cards, SmartApplications sends out Ethernet 802.3 test frames.

Ethernet Options (Port Attributes Tab)

Table 5-4 lists the options on the port attribute tab for an Ethernet port.

Table 5-4. Ethernet Options (Port Attributes Tab)

Field Description

Card Type The card type, such as Fast Card for 100Mb.

Card Model The card model number, such as ML-7710.

Signal Rate The port’s transmission rate in megabits per second. You set the rate for each port in a pair
separately. For Ethernet cards, possible values are: 10, 100, and 1000.

Duplex The port’s duplex mode. Possible values for Ethernet are Full and Half.

Note: Half-duplex currently is not supported on the LAN-3300A/3301A modules.

Protocol Select the protocol for the port.

The protocol you select shows or hides other fields on the tab. If you select IP or UDP, the
SmartCard's IP and Router's IP fields appear. If you select IPX, the Source Net and
Destination Net fields appear.

When testing a router, you must select either IP, UDP, or IPX. Options such as the All 0s
option refer to the packet contents (excluding MAC addresses).

Note: You must set the same protocol within a port pair. For example, you cannot configure
the transmitting port for IP and the receiving port for UDP.
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Destination MAC Specify the MAC addresses used. Default addresses correspond to the port numbers. For
example, for Ports 1 and 2 the Destination MAC are 000000000001 and 000000000002
respectively. To specify a different MAC address, enter a different value in the field. Repeat
this process until all the addresses are specified correctly for your test pairs.

Special conditions
• When testing a router, this value is the MAC address of the local router port.

• When testing a switch, this value is the MAC address of the destination SmartCard.

SmartCard MAC The MAC address of the sending port.

SmartCard's IP Enter the IP address of the port displayed on the tab. The SmartCard IP address should have
the same network address as the router port to which the port is connected, but with a
different host address.

Router's IP Enter the IP address of the router port to which the port is connected. If you are testing a
switch, you can use the default value.

Note: If you change direction in the port selection area of the main window, the
Destination MAC and SmartCard MAC and SmartCard's IP addresses remain unchanged in
the port attributes tab for each port. Be sure to verify that these fields reflect the correct
addresses.

Source Net The 4-byte network address of the transmitting port.

Destination Net The 4-byte network address of the router port (for router testing) or receiving port (for
switch testing).

Flow Control Enables traffic flow control.

Note: This field appears only for SX-7x10 and GX-1405 SmartCards. When this box is
checked and the SmartCard receives a pause frame, the card will stop transmitting for the
number of slot times specified in the pause frame. Default is Off (unchecked).

Auto Negotiation Auto-negotiation (AN) provides a means for the communicating interfaces at each end of a
link (the link partners) to exchange information about their speed and duplex capabilities,
and so to achieve the best possible mode of operation. The information exchanged in the
AN protocol is kept in memory registers termed MII registers. Values for this option are:

Continues –>

Table 5-4. Ethernet Options (Port Attributes Tab) (continued)

Field Description
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Click to open the Network IPs dialog. This allows you to define the contents of RIP
(Routing Information Protocol) packets. RIP packets are used to update routing tables and
are sent when testing over multiple hops.

Auto Negotiation
(Continued)

Disable
Sets register 0 and register 4 to the user-selected flow control, speed, and duplex (if
applicable) settings. Sets register 0 to Disable AN on this port. With this option, the port
does not participate in the AN protocol.

Force
Sets register 0 and register 4 to the user-selected flow control, speed, and duplex (if
applicable) settings. Sets register 0 to Enable AN on this port and sets the appropriate bit to
signal a restart of the AN process.

802.3 Format For Ethernet cards, SmartApplications sends out Ethernet 802.3 test frames. You can edit
the LLC (IEEE 802.2) header by selecting this option, then entering the desired values in
the three entry fields.

Field Offset Description
First 15 Destination Service Access Point (SSAP)
Second 16 Source Service Access Point (SSAP)
Third 17 Control Byte (LLC frame type)

Table 5-4. Ethernet Options (Port Attributes Tab) (continued)

Field Description
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Configuring Token Ring Ports
When you select a Token Ring port and the Show Card Attribute box is checked, the port
attribute tab displays Token Ring setup options.

Token Ring Options (Port Attribute Tab)

Table 5-5 lists the options on the port attribute tab for a Token Ring port.

Table 5-5. Token Ring Options (Port Attributes Tab)

Field Description

Card Type Displays the card type, in this case Token Ring.

Card Model Displays the card model number (TR-8405).

Signal Rate Select the transmission rate in megabits per second. For Token Ring
cards, possible values are 4 and 16.

Duplex Select the duplex mode. For Token Ring both TXI or TKP are
allowed.

Protocol Select the protocol for the port.

The protocol you select shows or hides other fields on the tab. For
example, if you select IP or UDP, the SmartCard's IP and Router's
IP fields are displayed. If you select IPX, the Source Net and
Destination Net fields are displayed.

When testing a router, you must select either IP, UDP, or IPX.
Options such as the All 0s option refer to the packet contents
(excluding MAC addresses).

Note: You must set the same protocol within a port pair. For
example, you cannot configure the transmitting card with IP and the
receiving card with UDP.
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Buttons – Status Pane

This pane on the tab for a Token Ring port shows the port’s current status (for example,
whether Early Token Release is enabled). It reflects the settings from the Token Ring
Properties window.

Network IPs
Click to open the Network IPs dialog. This allows you to define the contents of RIP
(Routing Information Protocol) packets. RIP packets are used to update routing tables and
are sent when testing over multiple hops.

Property
Click to open the Token Ring Properties dialog, which allows you to define the properties
of the Token Ring port (see “Defining Token Ring Properties” on page 76).

Destination MAC For router testing, this is the MAC address of the local router port.
The SmartCard's MAC destination address must be set to be the
MAC address of the router port to which the card is connected.

For switch testing using 1 to Many or Many to 1 tests, this is the
MAC address of the destination port.

SmartCard MAC The port’s MAC address. MAC addresses are 48 bits long, usually
written as 6 bytes in hexadecimal. For simplicity, set this to match
the port number in the SmartBits system. For example, port 1 would
be 00 00 00 00 00 01 for the transmitter and port 2 would be 00 00 00
00 00 02 for the receiver.

SmartCard's IP (This field and the Router’s IP field appear when you select IP or
UDP in the Protocol field.)

Enter the port’s IP address. The SmartCard’s IP address should have
the same network address as the router port to which the port is
connected, but with a different host address.

Router's IP Enter the IP address of the router's port to which the port is
connected. If testing a switch, this field can be the packet contents.

Source Net The 4-byte network address of the transmitting port.

Destination Net The 4-byte network address of the router port (for router testing) or
receiving port (for switch testing).

Table 5-5. Token Ring Options (Port Attributes Tab) (continued)

Field Description
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Defining Token Ring Properties

To specify properties for the Token Ring port, click the Property button on the port
attributes tab for a Token Ring port. This opens the Token Ring Properties window.

Table 5-6 lists the options in this dialog.

Table 5-6. Token Ring Properties Dialog

Field Description

Send Monitor Polls Enables the card to send out standby monitor polls in response to
active monitor polls.

Allow Early Token
Release

For 16MHz operation only, allows the SmartCard to release a
token prior to receiving its own transmitted frame back. This can
improve throughput, especially for small frames.

Use SRA Select to create the source routing field for Token Ring frames.
The fields used to enter source routing information become active.

When SRA is enabled, the source address for the frame is
automatically modified (before transmission) so that its uppermost
bit indicates to the network that the frame contains source routing
information. You must ensure that the field contents are correct—
for example, the length specification must be valid for it to be
interpreted correctly by the network devices.

Port When selected, configures the SmartCard port as a Media Adapter
Unit (MAU) port.
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Source Route Addressing Area

The control bytes (first two bytes) in the Designators field are automatically updated
when you select any combination of options in this area of the window.

Table 5-7 lists the Source Route Addressing fields.

Station When selected, configures the SmartCard port as a station.

LLC test frames Select this radio button to use LLC test frames in the test.

SNAP frames Select this radio button to use SNAP frames in the test.

Table 5-7. Source Route Addressing Fields

Field Description

Designators Defines how you want to route source packets. Enter hexadecimal
values directly into this field or make selections from the other
fields in the Source Route Addressing area. As you select other
fields the Designators field reflects the changes in hexadecimal
code for:

SRA field length Enter or select the length of the routing information field in bytes,
including the control field. Range: 2 to 30 bytes.

Largest frame
allowed

Enter or select the largest frame size that can be transmitted
between two communicating stations on a specific route.
Available values are: 516, 1470, 2052, 4472, 8144, 11407, 17800,
and Broadcast. The Broadcast setting is normally used in explorer
frames.

Table 5-6. Token Ring Properties Dialog (continued)

Field Description

SRA Length
Largest frame allowed
Address Control => 2-byte control field
Return Path
Direction
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Access Control This bit specifies the route through the network that the frame
should travel. Options are:

Broadcast
Select this radio button if you want the frame transmitted along
every route in the network to the destination station (often
resulting in many copies of the frame).
When you select Broadcast, the Number of Hops field displays.
Select this option to test the Token Ring source routing number of
bytes that will be in the system offset.

Non-Broadcast
Select this radio button if you want the segment number fields to
contain the specified route through the network that the frame is to
travel.

System Offset
Enter the number of bytes offset by the source routing information
inserted by the DUT into each frame.

Return Path This bit defines a single path return or return through all available
paths. Options are:

All routes return
Select this radio button for a single path return.

Single path return
Select this radio button for return through all available paths.

Direction This bit determines whether the of ring numbers and bridge
numbers in the routing information field are read from left to right
or right to left by the network devices.

Outgoing SRA
Select this radio button for the bridge to interpret the routing
information field from left to right

Return SRA
Select this radio button for the bridge to interpret the routing
information field from right to left.

Table 5-7. Source Route Addressing Fields (continued)

Field Description
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Configuring ATM Ports
When you select an ATM port, the port attribute tab display ATM options.

Summary of Steps to Configure an ATM Port

Use the following steps to configure an ATM port using the port attributes tab:

1 Set up the line parameters. Click Line Param to open the Port Configuration win-
dow.

2 Set up the protocol. Click ELAN Param to open the ELAN Registration window.

3 Add and configure at least one ELAN from the ELAN Registration window.

4 Specify the MAC addresses for the local router port and the SmartCard, and other
options, by using the port attributes tab.

Note: See “Set up ATM 1-to-Many/Many-to-1 Tests with PVC CLIP” on page 123 for
additional information on setting up ATM tests.

ATM Options (Port Attributes Tab)

Table 5-8 lists the options on the port attributes tab for an ATM port.

Table 5-8. ATM Options (Port Attributes Tab)

Field Description

Card Model Displays the model number of the card, such as AT-9025.

ELAN Name This field is displayed if you select SVC for the Connection Type
field and 802.3 for the Encapsulation type.

Select the name of the ELAN you want to use for the test. This field
is blank if you have not yet set up any ELANs. Click the ELAN
Param button to access the ELAN Registration window to set up
ELANs.
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VPI-VCI This field is displayed if you select PVC for the Connection Type
field. Enter the contents in decimal or hexadecimal of the header
portion of the cell.

Connection Type The type of virtual circuit for the connection between the SmartBits
chassis and the device under test. This field controls the options
available in the Encapsulation field. The possible values for
Connection Type are:

SVC
Switched Virtual Circuit. The connection is established only when
needed.

PVC
Permanent Virtual Circuit. The connection is permanently
established.

SmartCard's IP (This option is active when you select PVC for the Connection Type
field.) Enter the port’s IP address. The SmartCard’s IP address must
have the same network number and subnet address as the router port
to which the port is connected. Use the IP address of the outer port
with its last digit modified as the IP source address of the port.

Destination IP (This option is active when you select PVC for the Connection Type
field.) Enter the IP address of the receiving SmartCards.

Encapsulation The possible values for this field depend upon the value set for
Connection Type, as follows:

If Connection Type is PVC, the possible values for Encapsulation
are:

• SNAP

• Classic IP

• VC Mux Routed

If Connection Type is SVC, the possible values for Encapsulation
are:

• SNAP

• 802.3 (Ethernet)

• Classic IP

• VC Mux Routed

For Bridged RFC 1483: Select SNAP.

Continues –>

Table 5-8. ATM Options (Port Attributes Tab) (continued)

Field Description
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Buttons

Line Param
Click this button to access the Port Configuration window, to specify physical interface
parameters such as framing and loopback, as well as other ATM protocol information.

ELAN Param
Click this button to access the ELAN Registration window, to specify LAN Emulation
client information and to register ELANs.

Encapsulation
(continued)

For RFC 1577 or Routed RFC 1483 (using Routed SNAP, IP, or
UDP protocols): Select Classic IP.

VC Mux Routed: VC Multiplexing creates a binding between an
ATM VC and the type of the network protocol carried on that VC.
Thus, there is no need for protocol identification information to be
carried in the payload of each AAL5 CPCS-PDU. This reduces
payload overhead and can reduce per-packet processing. VC
multiplexing can improve efficiency by reducing the number of cells
needed to carry PDUs of certain lengths. (RFC2684).

SNAP (Subnetwork Access Protocol) uses the subnetwork and
performs data transfer, connection management, and QoS selection.

Fill Pattern The protocol to use for the payload. If you selected PVC for the
Connection Type, the fill pattern is IP or UDP.

Destination MAC For switch testing in 1 to Many / Many to 1 tests, this is the MAC
address of the destination port.

For router testing, this is the MAC address of the local router port. If
you do not specify an address, you will get zero throughput. The
SmartCard's MAC destination address must be the MAC address of
the router port to which the port is connected—for example, a MAC
destination of 08 00 02 06 89 22 for the transmitter and 08 00 02 12
27 22 for the receiver.

SmartCard MAC The MAC address of the SmartCard. MAC addresses are 48 bits
long, usually written as 6 bytes in hexadecimal. For simplicity, set
this to match the port number in the SmartBits system. For example,
port 1 would be 00 00 00 00 00 01 for the transmitter and port 2
would be 00 00 00 00 00 02 for the receiver.

Table 5-8. ATM Options (Port Attributes Tab) (continued)

Field Description
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Defining ATM Line Parameters

Use the Port Configuration dialog to define the physical interface for the ATM card. It
contains the following tabs:

Line Params
Use this tab to specify physical interface parameters, such as framing and loopback. See
“Line Params Tab” on page 83.

SSCOP
Use this tab to specify the UNI version and timer values for SSCOP. See “SSCOP Tab”
on page 87.

UNI
Use this tab to specify the UNI version and various timer values for UNI. Currently used
for point-to-point only, the UNI configuration offers the standard user-side timers and a
special testing teardown timer. See “UNI Tab” on page 89.

ILMI
Use this tab to define the method used by an ATM card to acquire its 20-byte ATM
address from the network device to which it is connected. See “ILMI Tab” on page 91.
SmartApplications User Guide



Chapter 5: Set Up Tests
Configure Test Ports
Line Params Tab

Table 5-9 lists the options on the Line Params tab of the ATM Port Configuration dialog.

Table 5-9. Line Params Tab — ATM Port Configuration Dialog

Field Description

Framing
Mode

Select to define the physical layer of the frame. Possible values are:

• AT-9025 25 Mbps SmartCard

ATM 25 Indicates direct cell mapping at 25.6 Mbps.

• AT-9015 DS1 SmartCard

• DS1 Cell - Maps the ATM cells directly into the DS1 frame with
no intermediate mapping.

• DS1 PLCP - Maps the ATM cells into PLCP frames and maps the
PLCP frames into the DS1 frame.

• AT-9020 E1 SmartCard

• E1 Cell - Maps the ATM cells directly into the E1 frame with no
intermediate mapping.

• E1 PLCP - Maps the ATM cells into PLCP frames and maps the
PLCP frames into the E1 frame.

• AT-9034B E3 SmartCard

• E3 Cell - Maps the ATM cells directly into an E3 G.832 frame
with no intermediate mapping.

• E3 PLCP - Maps the ATM cells into the PLCP frames and maps
the PLCP frames into an E3 G.751 frame.

• AT-9045 DS3 SmartCard

• DS3 Cell - Maps the ATM cells directly into the DS3 frame with
no intermediate mapping.

• DS3 PLCP - Maps the ATM cells into PLCP frames and maps the
PLCP frames into the DS3 frame.

• AT-9155C ATM OC-3c 155 Mbps

• OC3 - For SONET, OC-3c type of optical carrier line.

• STM1 - Enables the European STM 1 framing method (equiva-
lent to OC-3c)

• AT-9622 ATM OC-12c 622 Mbps SmartCard

• OC12 - For SONET, OC-12c type of optical carrier line. The
SmartCard maps the ATM cells directly into a SONET OC-12c
frame.

• STM4 - Enables the European STM-4 framing method (equiva-
lent to OC-12c). The SmartCard maps the ATM cells directly into
an STM-4 frames.
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Tx Clock
Source

This field does not apply to the AT-9025 SmartCard, which uses only an
internal clock. Specifies the clock against which you want to run the tests.
Possible values are:

Internal
Uses an internally generated clock as the transmit clock.

Loopback
Uses the recovered (received) clock as the transmit clock.

Loopback Specifies the type of loopback to be used. Possible values are:

Disabled
No loopback is used. This is the normal operating mode of the device.

Local
Loops card output back to the card's input.

Remote
Traffic returns to the remote machine.

Errored Cells
Handling

Specifies the action to take for cells with errors. Possible values are:

Drop Errored Cells
Drops all cells that have a header error as determined by the HEC byte.

Receive Errored Cells
Receives all cells even if they have errors.

Receive and Correct Errored Cells
Receives and corrects all cells with single-bit header errors.

Table 5-9. Line Params Tab — ATM Port Configuration Dialog (continued)

Field Description
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Buildout This field applies only to the AT-9015 DS1 and AT-9045 DS3
SmartCards. Select to change possible values for the electrical output of
the SmartCard to either:

1 Accommodate the length of the cable with which you are testing or,

2 Specify the amount of attenuation to apply to the signal.

AT-9015 DS1

• Cable Lengths

• <=133 Feet
Pulse shaping for cable lengths up to 133 feet.

• >133, <=266 Feet
Pulse shaping for cable lengths more than 133 feet and up to 266
feet.

• >266, <=399 Feet
Pulse shaping for cable lengths more than 266 feet and up to 399
feet.

• >399, <=533 Feet
Pulse shaping for cable lengths more than 399 feet and up to 533
feet.

• >533, <=655 Feet
Pulse shaping for cable lengths more than 533 feet and up to 655
feet.

• Buildout Attenuation Values

• -7.5 dB
Pulse shaping to generate -7.5 dB of attenuation.

• -15.0 dB
Pulse shaping to generate -15.0 dB of attenuation.

• -22.5 dB
Pulse shaping to generate -22.5 dB of attenuation.

AT-9045 DS3

• Cable Length

• <= 225 Feet
Pulse shaping for cable lengths up to 225 feet.

• >225 Feet
Pulse shaping for cable lengths more than 225 feet.

Table 5-9. Line Params Tab — ATM Port Configuration Dialog (continued)

Field Description
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Line Coding This field applies only to AT-9015 DS1 and AT-9020 E1 SmartCards.
Select the type of encoding to be used for the line. The possible values are:

AMI
Uses AMI line encoding.

B8ZS
DS1 mode using B8ZS line encoding. (AT-9015 only).

HDB3
E1 mode using HDB3 line encoding (AT-9020) only.

Line
Framing

This field applies only to the AT-9015 SmartCard. Select the framing
mode for the physical layer. The possible values are:

D4
Uses D4 line framing.

ESF
Uses Extended Super Frame line framing.

Cell
Scrambling

When checked, the payload of the cells is scrambled to facilitate cell
delineation. Most ATM devices require this feature to be on.

HEC Coset When checked, exclusive ORs the HEC with the bit pattern 0x55. Most
ATM devices require this feature to be on.

Idle Cell
Header

Specifies the header contents (4-bytes in hexadecimal) of the ATM idle
cell payload that is transmitted when no data cells are being transmitted.

Table 5-9. Line Params Tab — ATM Port Configuration Dialog (continued)

Field Description
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SSCOP Tab

Table 5-10 lists the options on the SSCOP tab of the ATM Port Configuration dialog.

Click the Default button to reset all timers to the SmartApplications default values.

Table 5-10. SSCOP Tab — ATM Port Configuration Dialog

Field Description

Max. CC Enter the maximum number of transmissions of a BGN, END, ER, to RS

PDU. Valid maximum value is 2 32 -1 (over 4 billion).

Max PD Enter the maximum number of SD PDUs that may be sent before sending a
POLL PDU. Value must be in the following range: 1 ≤ Max PD ≤ 25.

Max.
STAT

Enter the maximum number of list elements placed in a STAT PDU. Value
must be an odd number in the following range: 3 ≤ Max STAT ≤ 67.

Max.
Reseq

Enter the maximum receive resequencing queue depth in the following
range: 1 ≤ Max Reseq ≤ 16.

Max. Rx.
Windows

Enter the maximum number of unacknowledged SD PDUs that may be
received. Value must be in the following range: 1 ≤ Max Rx Windows ≤ 32.

Timer CC Enter the interval between transmission of BGN, END, RS, and ER PDUs as
long as acknowledgment to these PDUs has not been received.

Timer
Keep Alive

Enter the maximum time spent in the transient phase where POLL or STAT
PDUs may be lost.
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Timer Idle Enter the maximum time spent in IDLE phase before reverting to transient
phase.

Timer No
Response

Enter the maximum time interval during which at least one STAT PDU must
be received. Default is 10,000 ms for UNI 3.0; 7,000 ms for UNI 3.1.

Timer Poll Enter the interval between transmission of POLL PDUs. Default is 100 ms
for UNI 3.0; 750 ms for UNI 3.1.

Note: Timer values must not be zero.

Table 5-10. SSCOP Tab — ATM Port Configuration Dialog (continued)

Field Description
SmartApplications User Guide



Chapter 5: Set Up Tests
Configure Test Ports
UNI Tab

Table 5-11 lists the options on the UNI tab of the ATM Port Configuration dialog.
Table 5-12 on page 90 lists the UNI timers.

Click the Default button to reset all timers to the SmartApplications default values.

Table 5-11. UNI Tab — ATM Port Configuration Dialog

Field Description

Version Possible values are 3.0 User or 3.1 User (for SmartBits ATM cards).

Txx UNI timers. See Table 5-12 for descriptions.

Note: T398 and T399 will be implemented in a future release.

Teardown Enter the timer value (mandatory). This value is the time between teardowns
(call release requests) when resetting tests. A minimum of 10 milliseconds is
recommended to avoid test failure.

Note: Timer values must not be zero.
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Table 5-12. UNI Timers

Timer
Default
Timeout State of Call Cause for Start and Stop

T303 4s Call initiated Start: SETUP sent.
Stop: CONNECT, CALL PROCEEDING, or
RELEASE COMPLETE received.

T308 30s Release Request Start: RELEASE sent.
Stop: RELEASE COMPLETE or RELEASE
received.

T309 10s Any stable state Start: SAAL disconnection. Calls in the active state
are not lost.
Stop: SAAL reconnected.

T310 10s Outgoing Call
Proceeding

Start: CALL PROCEEDING started.
Stop: CONNECT or RELEASE received.

T313 4s Connect Request Start: CONNECT sent.
Stop: CONNECT ACKNOWLEDGE received.

T316 2 min. Restart Request Start: RESTART sent.
Stop: RESTART ACKNOWLEDGE received.

T317 < T316 Restart Start: RESTART received.
Stop: Internal clearing of call references.

T322 4s Any call state Start: STATUS ENQUIRY sent.
Stop: STATUS, RELEASE, or RELEASE
COMPLETE received.
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ILMI Tab

Table 5-13 lists the options on the ILMI tab of the ATM Port Configuration dialog.

Click the Default button to reset all values to the SmartApplications defaults.

Table 5-13. ILMI Options — ATM Port Configuration Dialog

Field Description

Method Select the method by which you want to register ILMI information.

Dynamic registration
Assigns the SmartCard address using information from the switch and
from the SmartCard.

Static registration
You define the 20-byte ATM address of the SmartCard. You must
also manually define the ATM address to the switch.

If you select Dynamic registration, the following fields appear:

• Cold Start Timer

• Register Timeout Timer

• End System Identifier (ESI)

If you select Static registration, the following fields appear:

• Prefix

• ESI

• Sel
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Cold Start
Timer

Defines the interval between ILMI Cold Start TRAP requests sent to
the switch when no network prefix has been registered. Default is
5000 ms.

Register
Timeout Timer

Defines retransmission interval of address registration SET requests
when no acknowledgement is received from the switch.

End System
Identifier (ESI)

Six bytes in the 20-byte ATM address for identifying the end station
(SmartCard in this case) on a particular user-to-network interface.
The first five bytes are user-definable. SmartApplications
automatically sets the sixth byte to a value that represents a specific
SmartCard.

Note: Timer values must not be zero.

Prefix The first 13-bytes of the ATM address.

Sel This field is disabled.

Table 5-13. ILMI Options — ATM Port Configuration Dialog (continued)

Field Description
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ATM ARP Tab

Table 5-13 lists the options on the ILMI tab of the ATM Port Configuration dialog.

Table 5-14. ATM ARP Options — ATM Port Configuration Dialog

Field Definition

ARP Server ATM
Address

The ATM address of the ATM ARP Server that must be running in
the system under test. This address must be a valid address of the
ATM ARP Server for Classical IP services to work properly.
Right-click on the field to copy/paste contents.

Inter ARP Gap The time in seconds between successive ARP request
transmissions. It is recommended that you keep this value larger
than 0 to avoid flooding the ATM ARP server with excessive ARP
requests.

Inter Call Gap The time in seconds between successive call setup for calls trying
to resolve the same destination IP address. It is recommended that
you keep this value larger than 0 to avoid overloading the
switching device under test.

ARP Retries Number of ARP retries to attempt before giving up.
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Defining ATM ELAN Parameters

To configure the ATM port, you must add and register an ELAN, if none exists. Before
you register an ELAN, ensure that:

1 ILMI is up or has already obtained the ATM address of the SmartCard.

2 SSCOP/UNI is up (that is, SSCOP in Data Transfer Ready State, and SAAL in Connected
state). The LEC has to set up SVCs to communicate with the LECS and LES.

You define and register ELANs by using the ELAN Registration window. Table 5-15 lists
the fields in the window.
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Table 5-15. Options in the ELAN Registration Window

Field Description

ELAN Name Select the name of an ELAN that you want to join. The name must
exactly match (case-sensitive) one of the ELAN names specified on
the device under test.

MAC Address The 6-byte MAC address of the LAN Emulation Client on the ATM
SmartCard.

ELAN Type LANE 802.3 is the only type currently supported.

ELANMTU Specify the maximum transmission unit of this ELAN.

ARP Retry Count Number of ARP retries to attempt before giving up.

Expected ARP
Resp. Time

Time to wait before retrying to send another LE_ARP or expiring
(time out).

Init Method Select the ELAN initialization method to match the setting of the
device under test. The possible methods are:

Normal
Default method. The LEC (LAN emulation client) on the ATM
SmartCard attempts to contact the LECS (LAN emulation client
server) at the default address specified by the ATM Forum to obtain
addressing information of the LES and BUS.

LECS Direct
Allows you to directly input the ATM address of the LECS. Use this
field if LECS does not reside at the default address specified by the
ATM Forum.

LES Direct
Allows you to input the ATM address of the LES. This method can
be used when no LECS service is available and the ATM address of
the LES is known.

LEC/LES Address This field is greyed out if you select Normal for the Init Method
field. Enter the ATM address of the LEC or LES.
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Configuring WAN Ports
When you select an WAN port, the port attribute tab display WAN options.

Table 5-16 lists the options on the port attribute tab for a WAN port.

Table 5-16. WAN Options (Port Attributes Tab)

Field Description

Card Type Displays the type of SmartCard for that port, in this case Frame Relay.

Card Model Displays the model number of the card, such as WN-3405.

Protocol Select the protocol for the port.

Values such as All 0s refer to the packet contents.

If you select IP or UDP for this field, the Smart Card’s IP and
Destination IP fields appear.

If you select IPX, the Source Net and Destination Net fields appear.

You must assign the same protocol within a port pair. For example, you
may not configure the transmitting port for IP and the receiving port for
UDP.

SmartCard's
IP

Enter the IP address of the SmartCard port. The SmartCard’s IP address
must have the same network number and subnet address as the router
port to which the port is connected. Use the IP address of the router port
with its last digit modified as the IP source address of the port.

Destination IP Enter the IP address of the receiving SmartCard.

Source Net The 4-byte network address of the transmitting card.

Destination Net The 4-byte network address of the router port (for router testing) or
receiving port (for switch testing).
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Destination
MAC

For switch testing using 1 to Many or Many to 1 tests, this is the MAC
address of the destination port.

For router testing, this is the MAC address of the local router port. If
you do not specify an address, you will get zero throughput. The
SmartCard's MAC destination address must be set to the MAC address
of the router port to which the card is connected—for example, the
destination MAC address is 08 00 02 06 89 22 for the transmitter and 08
00 02 12 27 22 for the receiver.

SmartCard
MAC

The MAC address of the SmartCard. MAC addresses are 48 bits long,
usually written as 6 bytes in hexadecimal. For simplicity, set this to
match the port number in the SmartBits system. For example,
transmitting port 1 would be 00 00 00 00 00 01 and receiving port 2
would be 00 00 00 00 00 02.

Table 5-16. WAN Options (Port Attributes Tab) (continued)

Field Description
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Line Mode This field is the same as the Line Physical Mode field on the Line tab of
WAN Port Setup window. If you change the value at the WAN Port
Setup window, the new value will be displayed here.

WN-3405 SmartCard

Select how you want to define the equipment mode (according to the
V.35 specification) within the Frame Relay User/Network interface.
Normally, the SmartCard is configured as DTE.

DTE
User side (also referred to as CPE or Customer Premises Equipment).

DCE
Network side

WN-3415 SmartCard

Select how you want to define the equipment mode within the Frame
Relay User/Network interface. Normally, the SmartCard is configured
as CSU/DSU.

CSU/DSU
Channel Service Unit/Data Service Unit (also known as Customer
Premises Equipment). Defines the SmartCard port as residing on the
customer (subscriber) side of the T1/E1 connection.

NET
Network side. Defines the SmartCard port as residing on the network
side of the T1/E1 connection.

WN-3420 SmartCard

Select how you want to define the electrical characteristics of the T1
interface. Normally, the SmartCard is configured as CSU/DSU.

CPE
Channel Service Unit/Data Service Unit (also known as Customer
Premises Equipment). Defines the SmartCard port to emulate the
customer (subscriber) side of the T1/E1 connection.

NET
Network side. Defines the SmartCard port to emulate the network side
of the T1/E1 connection.

Table 5-16. WAN Options (Port Attributes Tab) (continued)

Field Description
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Line Rate Applies only to the V.35 interface of the WN-3405 SmartCard.

This field is the same as the Line Rate (kbps) field on Line tab of the
WAN Port Setup window. If you change the value at the WAN Port
Setup window, the new value will be displayed here.

Select a line rate from 19.2 to 8192 Kbps. This value sets the internal
clock rate.

Encapsulation
Type

Select an encapsulation type to be used for the Frame Relay payload.
This field is the same as the Encapsulation Type field on Address tab of
the WAN Port Setup window. If you change the value at the WAN Port
Setup window, the new value will be displayed here

None
No encapsulation is used to send traffic. Select when source and
destination ports both use Frame Relay.

Bridged
Select if the device you are testing is a bridge.

Routed
Select if the device you are testing is a router.

DLCI The Data Link Connection Identifier for this PVC.

Table 5-16. WAN Options (Port Attributes Tab) (continued)

Field Description
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Defining WAN Port Parameters

As part of configuring a WAN port, you must specify the port’s physical parameters. You
do this using WAN Port Setup window. This window includes the following tabs:

Encapsulation
Use to select either Frame Relay or Point-to-Point Protocol (PPP).

Line (WN-3405, WN-3415 T1, WN-3420 E1)
Use to configure the physical characteristics of the port.

EIA Leads (WN-3405 only)
Use to select or deselect control signals on the V.35 line interface.

LMI (Frame Relay only)
Use to select a Link Management Interface (LMI) signaling protocol.

Address
Use to configure protocol addresses.

Line tab in WAN Port Setup window for WN-3415 SmartCard
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Line Tab (WN-3405)

With a WN-3405 Frame Relay SmartCard, use the Line tab of the WAN Port Setup
window to define the line rate and other physical characteristics.

Specify the line mode (DTE or DCE) first, then line encoding. If you use the WAN
SmartCards to both send and receive data, use the Line Clock options to synchronize the
sending SmartCard's data with the receiving SmartCard's clock.

Note: In a SmartCard test pair, you must configure one card as a DCE and one as a DTE.

Line Physical Mode

Select how you want to define the equipment mode (according to the V.35 specification)
within the Frame Relay User/Network interface. Normally you configure the SmartCard
as a DTE.

• DTE

User side (also referred to as CPE or Customer Premises Equipment).

• DCE

Network side

Line Clock

Select these radio buttons to synchronize the sending card with the clock on the receiving
card on a WN-3405 SmartCard.

• Tx Clock Src

Select the transmit clock source for the SmartCard. SmartApplications automatically
selects the External (default) radio button for Clock if you select DTE or the Inter-
nal radio button if you select DCE.

• Rx Clock Src

Select the type of clock source for the receiving SmartCard. If you select DTE Smart-
Applications automatically selects the External radio button for the Line Clock. If
you select DCE you must select which source you want for the clock.

• Internal − The SmartCard provides the clock internally for the receiving Smart-
Card.

• External (SCTE - 113) − Circuit 113 by default, a function (signal) on a V.35
connector pin, provides the clock for the receiving SmartCard.
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• Tx Clock Polarity

Select how you want the source port to transmit data in relation to clock timing. Since
the HDLC controller transmits data on rising edges only, when you change the clock
polarity to Falling Edge, the clock phase shifts 180 degrees with respect to the data.

• Rising Edge − Rising edge of the transmit clock coincides with the boundary of a
bit cell.

• Falling Edge − Rising edge of the transmit clock coincides with the middle (cen-
ter) of a bit cell. Select this option only if you use an external or isolated (buff-
ered) copy of the transmit clock.

• Rx Clock Polarity

Select the edge of the receive clock on which to sample received data.

• Rising Edge − Samples received data on the rising edge of the receive clock.

• Falling Edge − Samples received data on the falling edge of the receive clock.

Line Rate (kbps)
Select a line rate from 19.2 to 8192 Kbps. This value applies to the V.35 interface. The
value in this field sets the internal clock rate.

Other

Use these fields to specify additional parameters, such as line encoding and CRC, on a
WN-3405 SmartCard:

• Encoding

Select the encoding type for the V.35 interface. Possible values:

• NRZ − Non-return to zero.

• NRZI − Non-return to zero inverted.

• Min. Flags Between Frames

Select the number of flags (7E hexadecimal pattern) to be inserted between transmit-
ted frames. The maximum value is 127.

• CRC Enabled

Check this box to enable HDLC frame CRC generation. This field applies to transmit-
ting traffic only. When receiving traffic, the SmartCard always checks for CRC char-
acters.

• Checked − Enables the CRC (cyclic redundancy check). If checked, you can
select either 16-bit or 32-bit CRC generation.

• Unchecked − Disables CRC generation. The SmartCard's receive path still looks
for CRCs at the selected (but greyed out) size.
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• Zero Insertion/Deletion

Check this box to enable HDLC bit stuffing. This field applies to transmitting traffic
only. When receiving traffic, the SmartCard always performs bit unstuffing.

• Checked − Enables HDLC zero-bit stuffing for transmitting data and zero-bit
unstuffing for receiving data, to help distinguish a byte of data from a flag byte.

• Unchecked − Disables zero-bit stuffing and transmits raw (unencoded) data. The
SmartCard's receive path still performs bit unstuffing.
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Line Tab (WN-3415 / WN-3420)

With a WN-3415 or WN-3420 SmartCard, use the Line tab of the WAN Port Setup
window to define the physical characteristics of the port.

In a SmartCard point-to-point test pair, you must configure one card as a CSU/DSU and
one as a NET. Specify the line mode (CSU/DSU or NET) first, then line encoding.

Line Physical Mode

Select how you want to define the equipment mode within the Frame Relay User/Network
interface. Normally, the SmartCard is configured as CSU/DSU.

• CSU/DSU

Channel Service Unit/Data Service Unit (also known as Customer Premises Equip-
ment). Defines the SmartCard port as residing on the customer (subscriber) side of the
T1/E1 connection.

• NET

Network side. Defines the SmartCard port as residing on the network side of the T1/
E1 connection.
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• Loopback

Specifies the type of loopback to be used.

• Disabled − No loopback is used. This is the normal operating mode of the device.

• Local − Loops the SmartCard's output back to the SmartCard's input.

• Remote − Loops the SmartCard's input back to the SmartCard's output.

• Buildout

Select to change the electrical output of the SmartCard to either 1) accommodate the
length of the cable with which you are testing or 2) specify the amount of attenuation
to apply to the signal.

For the WN-3420 only: Select the type of cable with which you are testing:
Coax Normal, Cat-5 Normal, Coax High Loss, Cat-5 High Loss.

Possible values for Buildout Cable Length:

<=133 Feet Pulse shaping for cable lengths up to 133 feet.

>133, <=266 Feet Pulse shaping for cable lengths more than 133 ft. and up to 266 ft.

>266, <=399 Feet Pulse shaping for cable lengths more than 266 ft. and up to 399 ft.

>399, <=533 Feet Pulse shaping for cable lengths more than 399 ft. and up to 533 ft.

>533, <=655 Feet Pulse shaping for cable lengths more than 533 ft. and up to 655 ft.

Possible values for Buildout Attenuation:

-7.5 dB Pulse shaping to generate -7.5 dB of attenuation.

-15.0 dB Pulse shaping to generate -15.0 dB of attenuation.

-22.5 dB Pulse shaping to generate -22.5 dB of attenuation.

• Line Framing

Select the framing mode for the physical layer. Possible values:

• D4 − Uses D4 (Super Frame) line framing.

• ESF − Uses Extended Super Frame line framing.

• Line Encoding
Select the type of encoding to be used for the line. Possible values:

• AMI − Uses AMI (Alternate Mark Inversion) line encoding.

• B8ZS − Uses B8ZS line encoding. (WN-3415 only)

• HDB3 − E-1 mode using HDB3 line encoding. (WN-3420 only)

Transmit Clock Source
Specifies the clock against which you want to run the tests.

• Internal − Uses the SmartCard's internally generated clock as the transmit clock.

• Loop Timed − Uses the received clock as the transmit clock.
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Other

Use these fields to specify additional parameters, such as line encoding and CRC.

• Encoding

Select the type of encoding to be used for the line. Possible values:

• NRZ − Non-return to zero.

• NRZI − Non-return to zero inverted.

• Min. Flags Between Frames

Select the number of flags (7E hexadecimal pattern) to be inserted between transmit-
ted frames. The maximum value is 127.

• CRC Enabled

Check this box to enable HDLC frame CRC generation. This field applies to transmit-
ting traffic only. When receiving traffic, the SmartCard always checks for CRC char-
acters.

• Checked − Enables the CRC (cyclic redundancy check). If checked, you can
select either 16-bit or 32-bit CRC generation.

• Unchecked − Disables CRC generation. The SmartCard's receive path still looks
for CRCs at the selected (but greyed out) size.

• Zero Insertion/Deletion

Check this box to enable HDLC bit stuffing. This field applies to transmitting traffic
only. When receiving traffic, the SmartCard always performs bit unstuffing.

• Checked − Enables HDLC zero-bit stuffing for transmitting data and zero-bit
unstuffing for receiving data, to help distinguish a byte of data from a flag byte.

• Unchecked − Disables zero-bit stuffing and transmits raw (unencoded) data. The
SmartCard's receive path still performs bit unstuffing.
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Use the Channel Selection dialog box for Fractional T1 and E1. Select up to 24 channels
per SmartCard pair. This is the maximum number of 64 kbps circuits allowed on the T1
line to transmit and receive frames. If you select all of the channels, the line’s entire
bandwidth is used.

To select all channels

Click the Select All button.

To clear all channel selections

Click the Clear All button.

To select a range of channels

• Hold down the left mouse button and drag the mouse.

• Right click within the highlighted area. Use the popup menu to check or uncheck the
items you wish.
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Synchronizing WAN SmartCard Clocks

To transmit data, you must synchronize the clocks in the sending and receiving ports in
the test pair. Lack of synchronization can cause aborted frames and/or CRC errors when
transmitting flags, because the receiving SmartCard can mistake the flags for a frame or
abort sequence.

The following conditions can disrupt clock synchronization:

• Two ports in a test pair not set to the same clock polarity

• Delays from mismatched cables

• Induced noise

• Internal delays

• Long cables (over 10 feet)

Note: Bit cell width shrinks as frequency rises. Since cable and internal delays are a
function of the cable length, they are constant.

In DTE mode, some routers may try to recover their transmit clocks based on incoming
data. If this occurs, the falling edges of the transmit clock (which is derived from the
receive clock) may have excessive jitter. To avoid this, select Falling Edge for the receive
clock so that the sampling edge coincides with the middle of the bit cell period.
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LMP Tab

Use the LMP tab of the WAN Port Setup window to define the characteristics of the Link
Management Interface protocol. All the displayed values are industry-standard defaults. If
you modify these default values, you can restore them by clicking the Defaults button.

Table 5-17 lists the options on the LMP tab of the WAN Port Setup window.

Table 5-17. LMP Tab (WAN Port Setup Dialog)

Field Description

Link Management
Protocol

Select an LMP signaling method. The signaling method must match
what is configured in the connected device.

Logical Port Type Select the UNI DTE (User Side) or the UNI DCE (Network Side).

When connecting to a Frame Relay Switch, this value normally will
be UNI DTE.

If LMP is enabled and you configure the port as CSU/DSU, set this
field to UNI DTE. If you configure the port as NET, set this field to
UNI DCE.

DTE Full Polling
Cycle

Sets the number of polling cycles to complete before a Full Polling
Status Inquiry Message is sent by the DTE.
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Monitored Events
Count

Sets the number of Reliability Error events or In-Channel Signaling
Protocol Error events that can occur before a link is considered
inactive.

DTE Link
Integrity
Verification
Timer

Sets the frequency in seconds that Status Inquiry Messages are sent
when configured as a DTE.

DCE Polling
Verification
Timer

Sets the time that the interface waits for a Status Inquiry Message
before counting an error when configured as a DCE.

Table 5-17. LMP Tab (WAN Port Setup Dialog) (continued)

Field Description
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EIA Leads (WN-3405)

These radio buttons correspond to the physical pins on the connector.

Table 5-18 describes these options.

Table 5-18. EIA Leads Tab (WAN Port Setup Window)

Field Description

DCE Use these radio buttons to turn on or off:

• Data Set Ready (DSR)

• Clear to Send (CTS)

• Data Carrier Detect (DCD).

These signals apply only when Physical Line Mode is set to DCE.

DTE Use these radio buttons to turn on or off

• Data Terminal Ready (DTR)

• Request to Send (RTS)

These signals apply only when Physical Line Mode is set to DTE.

Note: The following signals are currently not supported:

• Test Mode (TM)

• Remote Loopback (RL)

• Local Loopback (LL)
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Address Tab

Use the Addresses tab to define IP and MAC addresses for the port and gateway.

Table 5-19 lists the options on this tab.

Table 5-19. Address Tab (WAN Port Setup Window)

Field Description

MAC Address Enter a source MAC address for sending Ethernet protocol frames,
when the selected encapsulation type is Bridged (Ethernet).

IP Address Enter an IP address for sending IP protocol frames.

Netmask Enter a subnet mask.

Gateway Enter the next hop IP address for the network.

Ping Target Enter the target IP address for the Ping packets.

Send Ping packet When checked, Ping packets will be sent to the Ping Target at the
rate in seconds that you enter in the a Ping Freq field.

Send SNMP
packet

When checked, SNMP Management packets will be sent to the
Gateway at the rate (in seconds) you enter in the SNMP Freq field.
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Send RIP packet When checked, RIP broadcast packets will be sent to out on all PVCs
on the above subnet at the rate (in seconds) you enter in the RIP Freq
field.

Reply to all ARP
requests

When checked, ARP replies will be sent in response to all ARP
requests not destined for configured streams on the specified IP
address or the IP address configured for the card.

Table 5-19. Address Tab (WAN Port Setup Window) (continued)

Field Description
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Encapsulation (FR only) Tab

Use the Encapsulation (FR only) tab to select the encapsulation type as Frame Relay or
PPP.

Table 5-20 lists the options on this tab.

Table 5-20. Encapsulation (FR only) Tab (WAN Port Setup Window)

Field Description

Frame Relay Click to select Frame Relay.

PPP Click to select Point-to-Point Protocol (PPP).
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To test routers with SmartApplications, you use procedures that are similar to those used
to test other devices, with the following differences:

Switch Testing

When testing a switch, you select the test ports in the card attribute tab of the main
window. Normally you can use the default protocol settings. This is not true for router
devices.

Router Testing

SmartApplications needs more information since the DUT is routing the IP/IPX packets
routed to the destination port. To test routers successfully, you must manually edit the IP/
IPX headers by using the Network IPs window. The Next Hop test is an additional test
you can perform with a router.

Preliminary Setup for Router Testing

Before testing a router, do the following:

• Check Router Test on the Preference tab in the Test Setup window.

• If you want to do a Next Hop test:

1 Check the Next Hop Test box in the on the Preference tab.

2 Click the Network IPs button on the card attributes tab to access the Network IPs
window, where you enter next-hop IP addresses.

• Obtain the MAC and IP addresses of the router ports involved in the test, and enter
them on the port attributes tab in the main window.

Router Test Configuration Fields

The port attributes tab contains fields that are specific to router tests. These are described
in Table 5-21 on page 116.
SmartApplications User Guide 115



Chapter 5: Set Up Tests
Router Testing

116
How the Router Test Runs
ARP learning
packets

At the beginning of each test repetition, every port involved in the test sends out a packet
to its test pair partner (using the test pair's MAC address). This should cause the router
under test to initiate an ARP exchange on the receiving ports to determine their MAC
addresses. All involved ports are set to recognize this ARP request when it comes in (by
using SmartCard triggers), and to respond with an appropriate ARP Reply (by using the
SmartCard Echo transmission mode). From that point, the router tables should be updated
and the test can continue.

Traffic through
the router

The transmitting port routes IP, UDP or IPX packets to the receiving port via the router to
the MAC and IP addresses specified on the card attributes tab on the main window.

Table 5-21. Router Test Configuration Fields

Field Description

Protocol The protocol for the port. Your selection here shows or hides other
options, as follows:

• If you select IP for the Protocol field, the SmartCard's IP field
appears.

• If you select IP or UDP, the Router’s IP fields appears.

• If you select IPX, the Source Net and Destination Net fields
appear.

For router testing, select either IP, UDP, or IPX.

SmartCard’s IP This field appears when you select IP or UDP for the Protocol field.
The IP addresses are entered in this field using dotted decimal
notation. The SmartCard IP address must have the same network
address, with a different host address, as the router port to which the
SmartCard is connected. For example, the SmartCard IP might be
192.168.100.2 for the transmitter and 146.72.1.2 for the receiver.

Router's IP This field appears when you select IP or UDP for the Protocol field.
The DUT IP address must be the IP address of the router port
connected to the card—for example, the DUT IP address for the
transmitter matches the router port IP, which is 192.168.100.1. Also,
the DUT IP for the receiver matches the IP of the connected router
port, which in this example is 146.72.1.1.

Source Net The 4-byte network address of the transmitting card.

Destination Net The 4-byte network address of the router port (for router testing) or
receiving card.

Destination MAC The SmartCard's MAC destination address must be set to the MAC
address of the router port to which the card is connected.
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Set up Next Hop Tests
The Next Hop test assesses a router's ability to recognize the next hop address in packets
and update its routing table accordingly. In Next Hop tests, all receiving ports act as
virtual router ports whose IP addresses you define in the Network IPs window.

How the Test Works

Figure 5-8 illustrates the topology for a Next Hop test.

At the start of each test, the receiving port sends the router a RIP packet. This contains the
virtual router port (host) addresses you defined in the Network IPs window. These are the
addresses of the networks you want the card to advertise. The router updates its routing table
with these IP addresses (this is known as the learning phase).

Once the router's has updated its routing table, the transmitting SmartCard sends packets
containing the host addresses (from the Network IPs) window to the router.

Figure 5-8. Diagram of Next Hop Topology
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Setting up the Test

To run a Next Hop test, you must enter the network IPs of the virtual routers (receiving
ports). Use these steps:

1 Check the Next Hop Test box in the Test Setup window.

2 In the SmartApplications main window, select IP or UDP or for the Protocol field.

3 Click the Network IPs button on the port attributes tab.

The Network IPs window displays.

4 Enter up to 15 valid network IP addresses. The network IP is formatted as a RIP
packet. The first three bytes represent a network address for a Class C IP address. The
last byte represents the host address and is not modifiable.
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Set Up IP/UDP/IPX Protocols
When you select a Layer 3 protocol of IP, UDP, or IPX in the Protocol field on a port
attribute tab, you must specify IP addresses for additional fields.

• If you select IP or UDP protocols, these fields are:

• SmartCards's IP

• Router's IP

• If you select IPX protocol, these fields are:

• Source Net

• Destination Net

For example, the figure below shows the SmartCard’s IP and Router’s IP fields in the port
attributes tab for a Gigabit card when IP has been set as the port protocol.

The following sections describe how to set IP addresses in different test situations.

To set up a Layer 3 protocol address

1 For routers:
Determine the MAC and IP addresses for each router port you are using in the test.
Enter them into the Destination MAC and Router IP fields respectively. MAC
addresses are in hexadecimal.

For switches:
You can use the default values.

Note: You must set the same protocol for a port pair. For example, you cannot configure
the transmitting port for IP and the receiving port for UDP.

2 Enter the SmartCard’s IP. Use the same network address as for the attached router
port, but with a different host address.
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Editing IPX Frame Format

You can customize IPX frame formats to define distant MAC addresses with distant IPX
network addresses, by using the port attributes tab in the main window:

Follow these steps:

1 Select IPX from the protocol pull-down menu.

2 Click the Edit button. The IPX Header window displays:

3 Enter the appropriate Hop type and socket values.

4 Close the IPX Header window by clicking the X button.

IPX requires that you provide a full address, including the distant network and the distant MAC.
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Editing UDP Frame Format

To customize the UDP format, follow these steps:

1 Select UDP from the protocol drop-down menu.

2 Click the Edit button. The UDP Header window displays:

3 Enter the source (SrcPort) and destination (DstPort) port numbers in the correspond-
ing UDP fields.

4 Close the UDP Header window by clicking the X button.

Example of Assigning Addresses for Protocols

Let us say you want to connect two SX-7410 SmartCards in Ports 1 and 2 to two ports of a
router. This example demonstrates how you might assign addresses for the protocols on
the card attribute tab.

1 Obtain the following addresses for the router's Port 1:

MAC address: 00 00 A5 E3 91 00

IP address: 146.72.1.1

2 Enter the router's IP and MAC Destination on the appropriate port attribute tab.

3 Attach the SmartCard in Port 1 to the router's Port 1.

4 Assign the SmartCard's Port 1 IP address with the same network address but with a
different host address as the router's Port 1. SmartApplications automatically assigns
the SmartCard's MAC address.

SmartCard Port 1: 146.72.1.2

Smart Card MAC address: 00 00 00 00 00 01

5 You obtain the following addresses for the router's Port 2:

MAC address: 00 00 A5 E2 91 00

IP address: 192.168.100.1

6 Enter the router's IP and MAC Destination on the appropriate port attribute tab.

7 Assign the SmartCard's Port 2 these addresses (for consistency):

SmartCard Port 2: 192.168.100.2

Smart Card MAC address: 00 00 00 00 00 02
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SmartApplications automatically issues the ARP exchanges to set up the router's ARP
table. The port attribute tab for Port 1 would look like this:
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Set up ATM 1-to-Many/Many-to-1 Tests with PVC CLIP
SmartApplications can perform 1-to-Many or Many-to-1 tests using ATM PVCs with
Classical IP encapsulation. When you set key parameters on the transmitting and receiving
cards correctly, SmartApplications will automatically generate the needed streams,
incrementing the VPI-VCI value and the Source IP Address in each stream.

Here is an example, with one transmitting port sending to three receiving ports.

Figure 5-9. Setting up PVC CLIP 1-to-Many or Many-to-1 Tests

With this one port-to-three-port configuration, SmartApplications will generate three
streams from the transmitting Card 1. In each stream, it will automatically increment the
VPI-VCI value in the cell header and the last octet of the Source IP address.

Setup Example

To set up this kind of test, use the parameters on the card attribute tab.

Figure 5-10 on page 124 illustrates the card attributes tab for the sending SmartCard and
the first receiving SmartCard. The following values have been set for the sending card:

• Connection Type = PVC

• Encapsulation = Classic IP

• VPI-VCI = 00 0800

• SmartCard’s IP = 192.168.81.2 (Source IP address)

• Destination IP = 192.168.1.74 (Target IP address for the first receiving card)

SmartCard 1
VPI-VCI: 0/800
Source IP: 192.168.81.2

SmartCard 2
VPI-VCI: 0/800
Source IP: 192.168.1.74

SmartCard 3
VPI-VCI: 0/801
Source IP: 192.168.1.78

SmartCard 4
VPI-VCI: 0/802
Source IP: 192.168.1.84

1 to Many

DUT

Resulting Test Streams Sent from SmartCard 1
Stream VPI-VCI Source IP Address

1 0/800 192.168.81.2

2 0/801 192.168.81.3

3 0/802 192.168.81.4

AT-9015 SmartCard

AT-9015 SmartCards
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In the setup for the sending SmartCard, you need to set the Destination IP Address of only
the first receiving SmartCard (in this example, Card 2).

In this example, the transmitting SmartCard will generate three streams. For each stream,
it will automatically increment the VPI-VCI value in the cell header and the last octet of
the Destination IP Address.

Figure 5-10. Parameter Settings for 1-to-Many / Many-to-1 Tests with PVC CLIP (Example)

SmartCard 1 - Sending SmartCard

SmartCard 2 - 1st Receiving Card

On the sending card, you need to set
the Destination IP of only the first
receiving card (for 1-to-Many).

On each receiving card, the SmartCard’s IP
and Destination IP are set to identify the
source IP address for the card and the
IP address of the sending card.
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This chapter explains the different phases of the test process and how to view, save, or
print test results.

In this chapter...

This chapter contains the following sections:

• Test Phases.....126

• Viewing Test Results.....127

• Generating HTML Test Reports.....133

• Viewing and Printing ASCII Text Report Files.....136

• Viewing Log Contents.....149
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Test Phases
When you start a test, it goes through several phases, including:

• Initialization of the DUT

• Learning phase

• Load generation

Device Under Test Initialization
When the test starts, SmartApplications first sends out learning packets so that the switch
or bridge can learn which addresses are local and which addresses need to be forwarded.
After the learning sequence, the actual load testing begins.

Learning Phase Adjustments

Some DUTs fail to update forwarding tables when the default number of learning packets
is sent (the default is 3). If the DUT does not update the forwarding table correctly using
the default number of packets, you can increase the number of learning packets that are
sent through the DUT, between the SmartBits transmitting and receiving ports.

To increase the number of learning packets:

1 Select Setup > Test Configuration.

2 In the Test Configuration window, increase the value in the Learning Retries field.
(The default value is 3.) This parameter determines how many retries will be made
(with a one-second delay between retries) before determining if a single packet can be
forwarded correctly.

Note: When testing routers, SmartApplications initiates an ARP exchange to update the
router’s ARP table before starting the learning phase.

Load Generation

The test now runs on the DUT, starting with the first selected packet size and following
the defined test methodology.

All selected ports run concurrently.
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Viewing Test Results
You can view test results on the Results window in several ways:

• Individual test tab — View results by test as the test runs.

• Reports tab — View a report of the test once it finishes.

• Log tab — View a running record of all repetitions of each trial of all tests.

Results Window by Test Tab

As soon as a test starts, SmartApplications displays the Results window for that test.
Figure 6-1 is an example of the Results window for the Acceptable Loss Throughput test,
with a chart showing test results.

Note: You can also open the Results window by selecting File > View Results File from
the main menu.

Figure 6-1. Results Window

Test setup

Counters

Overall test results

Tabs open different Results windows, by test type
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The Results window displays results as the test runs and until it finishes. It shows:

• The test setup, as specified in the Test Configuration window (upper part of window)

• Test counters (middle part)

• Overall test results (status bar at bottom of window)

To view the results of a different test:

Click one of tabs at the bottom of the Results window.

Note: For latency test results, SmartApplications measures and yields results for both
store-and-forward devices and bit-forwarding (cut-through) devices, regardless of the
DUT’s actual characteristics. Use the results that are appropriate for the device type.

When the test is complete, the word Ready displays in the lower-left corner of the
window, and final results display in the lower-right portion.

Results Window — Menu Options and Buttons
You can use the following menu options and buttons in the Results window.

Table 6-1. Results Window — Menu Bar Options

Action Menu Bar Option Button

Opens a previously saved Results file. Open Results File

Saves the information in the Results window to a file. Save Results File

Copies the information in the Results window to the
clipboard. You can paste the information to an
application such as MS Notepad  or MS Excel.

Copy Result

Prints the contents of the active tab on the Results
window.

Print Result

Stops the test.t Stop Test

Starts the test running. Start Test

Opens the Chart Wizard window, after you have
selected data to chart.

Create Chart
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Table 6-2 lists the fields on the status bar of the Results window.

Note: The Passed and Failed fields are not used in the Latency and Packet Loss tests.

Viewing the Results of Previous Configurations
You can view and print the test results that you saved from other configurations while still
in the current configuration.

To view the results of previous configurations:

1 Select File > View Results File from the menu bar. The Results window displays.

2 Select File > Open.

3 Select the .vts file containing the test results you want to view.

4 Click the Open button.

5 Click on a test tab to view test results.

Or, click one of the other tabs at the bottom of the Results window.

Table 6-2. Results Window — Status Bar Fields

Field Description

Frame size Size of frames being sent in this test.

Trial Number of the current trial.

Rep Number of repetition for the current trial.

Passed Percentage of traffic that passed the test without any packet loss.

Current Rate at which the current trial/repetition is being run.

Failed Last rate at which packet loss occurred.
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Viewing and Printing Test Reports
SmartApplications provides two types of report for each test type you run in a session:

• Detail report

• Summary report

In both report types, results are appended by packet size following each test trial. You can
produce individual reports for just one packet size.

Detail Reports

The detail report contains all results for every trial of each test type run during the test
session. For every packet size tested, SmartApplications appends the results of each trial
to a report table when the trial completes. You can view this table online or print it.

If you run all tests at once, the detail report contains results for all four tests. One report
table can hold up to 16384 rows (equivalent to many reports).

What the detail
report shows

Detail reports show, by packet size, the test progress including:

• Current trial number

• Operation in process (transmitting, receiving, retrieving data)

• Current rate

• Passed rate

• Approximate percent of completion

Detail report
formats

Detail reports are available in two formats:

• Tabular (default)
Displays results in columns by frame size.

• Non-tabular
Displays results in sequence by frame size.
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To change to the non-tabular report format:

• Select Setup > Test Configuration from the main menu (see Figure 6-2 on
page 131).

• Open the Preference tab.

• Uncheck the Create Tabular Report checkbox.

Figure 6-2. Specifying the Non-tabular Report Format

To view a detail report online

• Click the Reports tab of the Results window.

To print a detail report

• Select File > Print from the menu bar.

Note: For tabular reports only: You can only print data that is visible on your screen. If
the visible data on your screen exceeds physical page parameters, select File > Page
Setup from the menu bar and adjust your margins.

Uncheck Create
Tabular Report to
generate reports in
the non-tabular
format (see
“Viewing and
Printing Test
Reports” on page
130 for examples for
each test type.
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Summary Reports

SmartApplications also generates a summary report for each test type run during a session.
These reports summarize the results for each packet size (as in the Scott Bradner result
format).

For each test setup, SmartApplications appends the results by packet size to the summary
report at the end of a trial.

See Figure 6-9 on page 139 for an example of the summary report for a Throughput test.

Note: You must use an editor such as MS Notepad to view or print summary reports.

To create a separate report for each packet size:

1 Select Setup > Test Configuration...

2 Rename the file in the Report Filenames pane of the Preference tab.
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Generating HTML Test Reports
You can generate test results in HTML format.

To generate an HTML Report:

1 Select Setup > HTML Reports Setup... from the main menu.

2 Use the HTML Reports Setup dialog to set up the report output.

3 Check the Enable HTML Report checkbox to enable the HTML report.

The HTML Report Output Path field specifies the default location of the generated
HTML files. By default, these files are placed into a folder named html in the same
directory that contains the SmartApplications executable. You can also have them
written to another directory, if you wish. To do this, enter the desired path in the
HTML Report Output Path field.

Figure 6-3. Setting the Path for an HTML Report

The HTML Report Index File Name identifies the default index file, index.html. This
file contains links to the individual test result files. These are the files that are created
each time the test is run, or for each test iteration by packet size.

These links are in the following format (see Figure 6-4 on page 134 for an example):

<month><date><hour><minutes><seconds>
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Figure 6-4. Example of HTML File Name Links

4 Use the Test Comment field to specify a Test Comment (see Figure 6-4 on
page 134). The contents of the Vendor Name and Product Name fields can be set in
the SmartApplications main window (Figure 6-5). (These fields also are used for
ASCII test reports.)

SmartApplications generates all other field information automatically.

Figure 6-5. Setting the Vendor Name and Product Name for Reports

Figure 6-6 on page 135 shows a sample HTML test report.

Use these fields to set a “Vendor
Name” and “Product Name” to
appear in test reports.
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Figure 6-6. Sample HTML Test Report
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Viewing and Printing ASCII Text Report Files
You can print a detail report that contains the results of one test at a particular packet size.
SmartApplications assigns default filenames to individual report files (Table 6-3).

In each file name .nnn is a hexadecimal number representing the test frame size. For
example, if you run a Packet Loss test in which packet size is 64 bytes, the filename will
be PACKETLO.040 where 040 is the hexadecimal equivalent of 64 decimal.

To change the default file names:

You can change these default names (excluding the file extension):

1 Select Setup > Test Configuration...

2 Rename the file in the Report Filenames pane of the Preference tab.

Notes:

1 Summary reports use the file extension .ndt.

2 If you repeat a test at the same packet size, SmartApplications overwrites the first
detail report. To avoid this, rename the report file before repeating the test.

To print an individual test report (including a summary report):

1 Open an editor such as MS Notepad.

2 Select the file you want to print using File > Open.

3 Select File > Print.

Table 6-3. Default File Names for SmartApplications Tests

Test Type Default File Name

Throughput THROUGHP.nnn

Latency LATENCY.nnn

Packet Loss (Ethernet only) PACKETLO.nnn

Back-to-Back (Ethernet only) BAKTOBAK.nnn
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Sample Reports – Throughput Test
Figure 6-7 is an example of the report for the Acceptable Loss Throughput test in the
tabular format.

Figure 6-8 on page 138 shows the test report in the non-tabular format.

Figure 6-9 on page 139 is an example of the summary report.

Figure 6-7. Sample Detail Report for Throughput Test – Tabular Format

This format shows test results with
packet sizes arranged in column format.
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Figure 6-8. Sample Detail Report for Throughput Test – Non-tabular Format

This format shows test results with
packet sizes arranged in sequence.
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Figure 6-9. Sample Summary Report for Throughput Test

The summary report shows overall
results by packet size.
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Sample Reports – Latency Test
Figure 6-10 is an example of the Latency test report in the tabular format.

Figure 6-8 on page 138 shows an example of the test report in the non-tabular format.

Figure 6-9 on page 139 is an example of the summary report.

Figure 6-10. Sample Detail Report for Latency Test – Tabular Format
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Figure 6-11. Sample Detail Report for Latency Test – Non-tabular Format
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Figure 6-12. Sample Summary Report for Latency Test
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Sample Reports – Packet Loss Test
Figure 6-13 is an example of the Packet Loss test report in the tabular format.

Figure 6-14 on page 144 shows the test report in the non-tabular format.

Figure 6-15 on page 145 is an example of the summary report.

Figure 6-13. Sample Detail Report for Packet Loss Test – Tabular Format
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Figure 6-14. Sample Detail Report for Packet Loss Test – Non-tabular Format
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Figure 6-15. Sample Summary Report for Packet Loss Test
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Sample Reports – Back-to-Back Test
Figure 6-16 is an example of the Back-to-Back test report in the tabular format.

Figure 6-17 on page 147 shows the test report in the non-tabular format.

Figure 6-18 on page 148 is an example of the summary report.

Figure 6-16. Sample Detail Report for Back-toBack Test – Tabular Format
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Figure 6-17. Sample Detail Report for Back-toBack Test – Non-tabular Format
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Figure 6-18. Sample Summary Report for Back-toBack Test
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Viewing Log Contents
The SmartApplications log file provides detailed results for each test, as well as a running
record of what happened during the test. See Figure 6-19 for an example.

To view the log file, open the Log tab of the Results window.

Note: Always check the test log to make sure that the test has run correctly.

Figure 6-19. Sample Log File
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This chapter presents examples of the four SmartApplications tests, illustrating sample test
configurations for routers or switches. Although they will not match your test environment
exactly, they demonstrate how to run a test and how results should look. Naturally, you
should set up your test configurations to meet your specific requirements.

Note: All the examples described here apply to a router or switch. If the device under test
is a router, be sure to select Router Test on the Preference tab of the Test Setup window.

In this chapter...

This chapter contains the following sections:

• Throughput Test — Example.....152

• Latency Test — Example.....157

• Packet Loss Test — Example.....159

• Back-to-Back Test — Example.....161
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Throughput Test — Example
The Throughput test measures the fastest rate at which a device can forward frames
without error. If even a single frame is dropped, the test fails and is repeated at a lower
rate.

Setup — Throughput Test Example
In this example, we select Port 1 and Port 2 for testing, as shown below.

In the port attributes tabs for the selected ports, the values for Destination MAC and
SmartCard MAC correspond to the sending and receiving port numbers.

Note: In this example, the DUT is a switch. If we were testing a router, the Protocol field
would have to specify a Layer 3 protocol, rather than All 0s as shown here.

Figure 7-1 on page 153 illustrates the overall test configuration used for this example:

Ports 1 and 2 are selected as test ports.
SmartApplications User Guide



Chapter 7: Test Examples
Throughput Test — Example
Figure 7-1. Test Configuration for Example

Test setup This example uses the following setup:

• Initial Rate is 100%.

• Maximum rate is 100%.

• Minimum rate is 50%.

• Resolution is .5%.

• Acceptable Loss Percentage is not enabled (zero value).

To save time, frame sizes vary from a minimum of 64 bytes to a maximum of 128 bytes,
with a step size of 64.

How the test runs The test will run twice: once with 64-byte packets, and once with 128-byte packets. It will
start running at 100% and fall back if any packets are lost. The minimum rate is 50%.

Note: The rates in this example were selected to minimize the number of tests run. For
Ethernet, RFC 1242 actually recommends frame sizes of 64, 128, 256, 512, 1024, 1280,
and 1518 bytes (these are the default sizes in the Sizes list when you select Use Custom).
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Results — Throughput Test Example
The Results window appears as soon as the test starts. Figure 7-2 is an example of the
Results window for the Throughput test. In this case, it shows that the trial succeeded at
the first frame size and is continuing with the second frame size.

Because we selected two packet sizes (64 and 128 bytes), only two trials are shown.

Figure 7-2. Throughput Test Results Window (Example)

The current rate to which the test dropped.

The rate at which the test failed (if applicable).

This trial finished.

This trial is still running.
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Sample Test Log
The test log shows packets received and packets transmitted. Figure 7-3 illustrates the log
for this example. When there is a failure in a trial iteration, that field is shown in red.

Figure 7-3. Sample Test Log for Throughput Test

The difference between the number of packets transmitted and the
number of packets-with-triggers received indicates the packet loss.

Click on the Log tab to open the test log.
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Sample Test Report
Figure 7-4 illustrates the Test Report for the Throughput test example.

Figure 7-4. Sample Test Report

Click on the Reports tab to open the test report.
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Latency Test — Example
In Latency tests, the Min. Rate field does not apply.

Sample Test Configuration
The Setup Test Configuration dialog (Figure 7-5) shows the settings used in this example.

Figure 7-5. Test Setup for Latency Test Example

Test setup This test uses the following setup:

• 64-byte packets and 128-byte packets.

• Each trial will last 100 seconds (the RFC default), and there will be two trials (the
RFC default is 20).

• Learning Packets will be sent once before each test.

• Initial Rate is 50%, Step Rate is 25%, and Max Rate is 100%.

How the test runs These settings will cause the test to run in six trials: with 64-byte packets at 50%, 75% and
100%, and with 128-byte packets at 50%, 75% and 100%. The Latency test does not step
down in percentage of transmission. For example, if Initial Rate is 100%, Minimum Rate
50%, and Step Rate 25%, the test will run only at 100%.

Note: Rates in this example were selected to minimize the number of tests run. RFC 1242
specifies a minimum of 20 repetitions (Number of Trials) with a stream duration of 100
seconds. Recommended frame sizes for Ethernet are 64, 128, 256, 512, 1024, 1280, and
1518 (these are the default sizes in the Sizes list when you select Use Custom).
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Sample Test Results Window for Latency
Figure 7-6 illustrates the Results window for this example of the Latency test, with the test
still in progress. Test results are displayed for both cut-through and store-and-forward
devices. Use the measurement that is appropriate for your device type.

Figure 7-6. Sample Results Window for Latency Test

The 64-byte tests are complete at 50%, 75% and 100%, with a latency time of 0.1
microseconds for all rates. The 50% test with 128-byte packets is also complete with a
latency of 0.1 microsecond.

The status bar at the bottom of the window displays current activity:

• Performing triggers setup for the selected ports.

• Frame size being transmitted (128 bytes)

• Current trial count (1 of 2)

• Current rate (75.13%)

Note: Passed and Failed status indications are not used in the Latency test.

Use the Status bar to view current activity as the test runs.

These Status bar fields are not used in a Latency test.
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Packet Loss Test — Example
The Packet Loss Test measures the percentage of frames lost by the DUT that should have
been forwarded.

Sample Test Configuration
Figure 7-7 shows the settings used for this example of the Packet Loss test.

Figure 7-7. Test Setup for Packet Loss Test Example

Test setup This test uses the following setup:

• 64-byte packets and 128-byte packets.

• Each trial will last 10 seconds, and there will be one trial.

• Learning Packets will be sent once before each test.

• Initial Rate is 50%, Step Rate is 10%, and Max Rate is 100%.

How the test runs This test setup results in 12 trials: 64-byte packets are sent first at the 50% rate, then at
rates that increase in 10% increments. Then 128-byte packets are sent in the same way.

Note: Rates in this example were selected to minimize the number of tests run. The
recommended frame sizes for Ethernet are 64, 128, 256, 512, 1024, 1280 and 1518 bytes
(these are the default sizes in the Sizes list when you select Use Custom).
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Sample Results Window
Figure 7-8 illustrates the Results window for this example of a Packet Loss Test, with the
test still in progress.

Figure 7-8. Sample Test Results for Packet Loss Test

In this example the first trial ran at 50% with 64-byte packets and no packet loss. The loss
rate (0.000% lost) is shown in each this column identifying the port pair.

Subsequent trials ran at 10% higher rates, with 64-byte packets, and there was no packet
loss until the 90% rate, when .924% of the transmitted packets were lost. The next rate
(with 64-byte frames) also showed packet loss of .034%.

The Status bar shows that trials at the 128 frame size are just beginning, with test setup in
progress.
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Back-to-Back Test — Example
The Back-to-Back test assesses the buffering capability of the device under test.

Sample Test Configuration
Figure 7-8 shows the settings used for this example of the Back-to-Back test.

Test setup This test uses the following setup:

• 50 trials with a duration of two seconds each trial.

• Start at the 50% rate.

• Increase in 25% steps to a maximum of 100%.

• Start with 64-byte packets.

• Increase by 64 bytes in each trial to a maximum of 128-byte packets.

Note: Rates in this example were selected to minimize the number of tests run. RFC 1242
actually recommends at least 50 trials with a required minimum duration of two seconds
with frame sizes for Ethernet of 64, 128, 256, 512, 1024, 1280 and 1518 bytes (these are
the default sizes in the Sizes list when you select Use Custom).
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Sample Results Window
Figure 7-9 illustrates the Results window for the sample Back-to-Back test, with the test
still in progress. For this test, results show the number of frames in the longest burst that
the DUT handled without dropping a packet.

In this example, we used a jumper wire to connect the two ports under test. Therefore the
results shown here represent only the maximum number of frames of that size that can be
transmitted at the test rate.

Figure 7-9. Sample Test Results for Back-to-Back Test
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This glossary has two parts:

• “Acronyms and Abbreviations” expands short terms that appear in this document.

• “Terminology” defines longer terms in this document, as well as in networking
technology and standards generally.

Acronyms and Abbreviations

Acronym /
Abbreviation

Definition

AMI Alternate Mark Inversion.

ATM Asynchronous Transfer Mode. Transfer mode in which
information is organized into cells.

CPE Customer Premise Equipment.

CRC Cyclic Redundancy Check.

CSU Channel Service Unit.

CTS Clear to Send.

DCD Date Carrier Detect.

DLCI Data Link Connection Identifier.

DSR Data Set Ready.

DSU Data Service Unit.

DTR Data Terminal Ready.

DUT Device Under Test.

ELAN Emulated Local Area Network. A group of ATM and legacy
devices registered with the LES that constitute a logical
network.
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ESI End System Identifier.

FIFO First in/first out.

GPS Global Positioning System.

HTML HyperText Markup Language. A collection of platform-
independent styles, indicated by markup tags, that define the
components of a document on the World Wide Web. You can
have SmartApplications generate test reports in HTML format.
Select Setup > HTML Reports Setup from the main menu.

ILMI Interim Local Management Interface. Discovers and registers
ATM addresses of attached hosts.

IP Internet Protocol. Works in conjunction with TCP and is
usually identified as TCP/IP.

IPX Internetwork Packet Exchange.

LAN Local Area Network. Designed to move data between stations
within a campus.

LEC Lan Emulation Client. A device such as a server, switch, or
workstation that performs ATM signaling and control
functions while communicating with other devices in an
ELAN. Every LEC Client has an ATM address and a MAC
address.

LECS LAN Emulation Configuration Server. Provides mapping
information about ELANs on the ATM network that an LEC
may join.

LES LAN Emulation Server. Registers the MAC addresses of each
LEC on the non-ATM LAN and resolves the MAC address to
an ATM address.

LIFO Last in/first out.

LMP Link Management Protocol.

NRZ Non-return to zero.

NRZI Non-return to zero inverted.

PCB Printed Circuit Board.

Acronym /
Abbreviation

Definition
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PPP Point-to-Point Protocol.

PVC Permanent Virtual Circuit. A dedicated channel between
endpoints through an ATM network used for long-term data
transfer.

RFC Request For Comments. Document series used as the primary
means for communicating information about the Internet.

RIP Routing Information Protocol.

RTS Request to Send.

SMB SmartBits.

SNAP Subnetwork Access Protocol.

SRA Source Route Addressing.

SVC Switched Virtual Circuit. A connection established through
signaling with user-defined endpoints when the call is
initiated.

UDP User Datagram Protocol. Connectionless transport layer
protocol in the TCP/IP protocol stack.

VCI/VPI Virtual Channel Identifier/Virtual Path Identifier. A
connection in the form of a channel which has been
successfully initialized and on which data is ready to be
transmitted and received. Provides mapping information for
routing cells from a source to destination.

WAN Wide Area Network.

Acronym /
Abbreviation

Definition
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Terminology

Acceptable Loss Throughput
A mode for the Throughput test. It enables you to specify how much frame loss should be
considered acceptable when judging the trial successful or failed. This makes it possible to
compensate for frame loss caused by small differences in clock tolerances between the
SmartBits port and the DUT port.

Back-to-Back test
Tests the buffering capability of the device under test (DUT).

bi-directional
Port pairs transmitting simultaneously in both directions, as in full-duplex operation.

card

In this manual, refers generally to any SmartCard or module for a SmartBits system.

frame

A data pattern that a stream transmits.

hub

The SmartBits chassis that contains SmartCards or modules.

iteration
An iteration is when SmartApplications, while maintaining the frame size, varies the
transmission rate based on the last failed rate. The resolution and number of repetitions
determines the accuracy of results.

latency
Delay between the time a device receives a frame and the time that frame is forwarded out
the destination port.

MAC address
A 6-byte IEEE identifier for hardware devices, sometimes called a hardware address.

Next Hop test

Tests a router’s ability to recognize the next hop address and update its routing table with
this address.

Packet Loss test

Measures the percentage of frames lost by the device under test (DUT) that should have
been forwarded.

port

In a SmartBits chassis, the port on a SmartCard or module.

slot
On a SmartBits chassis, a slot is where the SmartCard or module is inserted.
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stream
A software engine on SmartBits cards that transmits a frame pattern repeatedly.

test
Refers to the test (such as Throughput or Latency) run for a particular frame size.

Throughput test

Tests the fastest rate at which a device can forward frames without error.

trial

One set of iterations for a specific fame size and varying transmission rates. Tests use trials
to determine the optimal rate of traffic for that frame size.
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1-to-1 tests

running 31, 64
1-to-Many/Many-to-1 tests

running 66
selecting ports for 32

A
Acceptable Loss Throughput 13
Actions menu 25
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allowable port pair combinations 61
ATM

1-to-Many/Many-to-1 tests with PVC CLIP 123
ATM ARP tab 93
configuring ports 79
ELAN 94
ILMI tab 91
Line Params tab 83
PVC CLIP 123
SSCOP tab 87
UNI tab 89

auto negotiation 72

B
Back-to-Back test

methodology 17
scenario 161

baud rate 38
bi-directional testing 31, 64

C
card

defined 7
card attributes, viewing 31
Channel Selection window 107

T-1/E-1 107
chart of results 33
Classical IP (CLIP) 123
clocks

polarity (WN-3405) 102
synchronizing in remote chassis 43
synchronizing WAN ports 108
transmit clock source (ATM) 84
transmit clock source (WAN) 101, 105

Configuration Tab options 51
configurations, viewing previous 129
configuring

ATM ports 79
duplex 68
Ethernet ports 71
Frame Relay ports 96
multiple ports at one time 68
pair of ports at a time 70
protocol 68
speed 68
test ports 67
test setups 48
Token Ring ports 74
WAN ports 96

connecting
multiple chassis 42
the device under test 36
to the Ethernet port 40
to the serial port 38

creating a chart of results 33

D
detail reports 130

E
E-1 channel selection 107
encapsulation 100, 114
Ethernet port

connecting to 40
linking multiple Smartbits controllers 42

examples
assigning addresses for protocols 121
Back-to-Back test 161
how test configuration settings work 52
Latency test 157
Packet Loss test 159
Throughput test 152

F
File menu 25
flow control 58, 72
fractional T-1/E1 channel selection 107
Frame Relay 100

configuring 96
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General Area options (Test Configuration tab) 49
general testing methodology 10
GPS 43

H
Help menu 27
HTML test reports 133
hub/slot/port designations 42

I
identifying ports 61
ILMI parameters (ATM) 91
individual reports

viewing and printing 133, 136
Intended Load 58
invalid COM Port 39
IP protocol 119
IPX protocol 119

L
LAN-3300A/3301A

duplex setting 68
speed setting 68

Latency test
methodology 14
scenario 157

Launch buttons 28
learning packets 11, 51
line clock options 101
line parameters

ATM 83
WAN cards 101, 104

M
main window 25

port selection area 31
toolbar 29

methodology
Back-to-Back test 17
general 10
Latency test 14
Packet Loss test 16
Throughput test 12

modules
defined 7

multiple chassis
linking 42
synchronizing clocks with GPS 43

N
Network IPs window 73
Next Hop test

setting up 118
null modem cable 39

O
Offered Load 58
online Help 4

P
Packet Loss test

methodology 16
scenario 159

packet sizes, customizing 54
port numbering 61
ports

configuring ATM 79
configuring Ethernet 71
configuring individually 70
configuring multiple 68
configuring Token Ring 74
configuring WAN 96

PPP 100, 114
Preference tab 55
printing individual reports 133, 136
protocols 119
PVC CLIP (Classical IP) 123

R
reports

ASCII text report files 133, 136
detail 130
HTML 133
viewing and printing 133, 136

reserving SmartCards 44
Results window

Back to Back test 162
Latency test 158
menu options and buttons 128
Packet Loss test 160
Throughput test 154
viewing 154

RFC 2544 12
router

Next Hop tests 118
testing 115

RS-232 cable 39
Run menu 26

S
sample configuration

Latency test 157
Throughput test 152

saving a test configuration 59
selecting test ports 60
setting up a test, summary 36
setting up test configurations 48
Setup menu 26
Setup SmartBits Connections window 26
SmartApplications

overview 6
SmartBits chassis

connecting to 39
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saving 59
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viewing

test results 127
viewing test results 154
virtual port numbering 61
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configuring ports 96
WAN Port Setup

Address Tab 112
EIA Leads Tab (WN-3405) 111
Encapsulation Tab 114
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WAN ports
configuring 96
setup 100
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